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Abstract 

The Gamma Detector Response and Analysis Software–Detector Response Function (GADRAS-DRF) 

application computes the response of gamma-ray and neutron detectors to incoming radiation. This 

manual provides step-by-step procedures to acquaint new users with the use of the application. The 

capabilities include characterization of detector response parameters, plotting and viewing measured 

and computed spectra, analyzing spectra to identify isotopes, and estimating source energy distributions 

from measured spectra. GADRAS-DRF can compute and provide detector responses quickly and 

accurately, giving users the ability to obtain usable results in a timely manner (a matter of seconds or 

minutes). 
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1 INTRODUCTION 

1.1 GADRAS-DRF Overview 

GAmma Detector Response and Analysis Software – Detector Response Function (GADRAS-DRF) 

contains a suite of capabilities related to radiation detection. Its primary function is the simulation of 

gamma-ray and neutron detector signals to radiation sources. It also contains limited analysis 

functionality. GADRAS-DRF is the public version of the full version of GADRAS [1] with capabilities such 

as radiation transport [2] [3] and advanced analyses [4] removed. 

Features in a gamma-ray detector spectrum; such as photopeaks and the Compton continuum, are 

derived from first-principles calculations based on interaction cross sections. Neutron detector response 

is computed by interpolating on a pre-computed database of thermal (3He) detector responses [5] [6]. 

For both gamma-ray and neutron detectors, the response to radiation that scatters into the detector 

from the surrounding environment is determined by a combination of first-principals calculations and 

empirical modeling [7]. For new detectors, known detector parameters such as size and resolution are 

all that is necessary to compute an initial response function. This response function may be refined by 

measuring calibration sources and fitting the detector’s parameters to match the data. 

 

Figure 1 is a screen-capture of the GADRAS-DRF main window. The program contains eight main tabs 

that run across the top of the window (Detector, Plot, TimeHistory, Analyze, Neutron, Inject, Tools, and 

Setup). Each tab represents a primary function of GADRAS-DRF; these are referred to as tabs in this 

document (e.g. Plot tab). Most tab pages have a primary function initiated by clicking a large button in 

the bottom right corner of the screen. The title of the main window displays the current version and 

currently selected gamma-ray detector. GADRAS-DRF must always have a current gamma-ray detector 

selected, even if the current operation does not require a detector response function (e.g. plotting a 

measured spectrum). Neutron detectors are optional; the current detector name will also appear on the 

main window title if selected.  
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1.2 Directory Structure 

Within the root GADRAS-DRF directory (default is C:\GADRAS-DRF), there are four primary directories: 

(1) Detector, (2) Source, (3) Temp, and (4) Program (Figure 2).  

 

Figure 2. Overview of GADRAS-DRF Directory Structure 

 

The Detector directory contains subdirectories, each for a different gamma-ray detector. The name of 

the subdirectory indicates the name of the detector; thus, each gamma-ray detector requires its own 

directory. However, multiple neutron detectors can be added to a single gamma-ray detector directory. 

A common practice is to use a gamma-ray detector directory as a scenario or experiment repository 

containing documents and measured spectra. Therefore, detector directory names are also based on 

experiments (e.g. “GADRAS-DRF\Detector\BeRPBall”). 

Common source files shared among multiple detectors are stored in the Source directory. Source files 

may be stored in individual detector directories as well.  

The Temp directory is cleaned with each new instance of GADRAS-DRF. It contains temporary files which 

facilitate faster operation of the program as well as log files which record debugging information. Most 

users will not need to explore this directory. 
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The main executable is located in the Program directory at “GADRAS-DRF\Program\GADRAS-DRF.exe” 

along with associated shared libraries. This also contains a Documentation directory which contains this 

user’s manual as well as example codes that utilize the GADRAS-DRF API. 
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2 DETECTOR RESPONSE FUNCTION  

2.1 Creating New Detectors 

Each detector directory contains a file named Detector.dat, which contains the response function 

parameters. Response function parameters do not normally require adjustment after initial 

characterization. Specific situations where parameter adjustments are necessary include: 

 change in source-to-detector distance or height from the floor; 

 adjustments needed due to mechanical damage, chemical deterioration, high voltage bias 

change, shielding, etc. that have caused the detector to change its characteristics substantially; 

and 

 drastic changes in the measurement environment from which the detector was characterized. 

2.1.1 Using the Create New Detector Screen: Clone or Create Options 

A new detector setup within GADRAS-DRF can be created from the Detector tab on the main window. 

To create a new detector, the user selects Create New Detector from the drop-down menu as shown in 

Figure 3 (top). This action opens the Create New Detector form shown in Figure 3 (bottom), which 

allows users to clone an existing detector or create a new detector. 

The following entries are mandatory for creating new detector setups: 

1) Detector name: Users should create a unique name for the detector. 

2) Parent directory: The parent directory for the detector. By default, this is the main detector 

directory “GADRAS-DRF\Detector”. Any subdirectory of the main detector directory may be used 

(including existing detector directories) to be the new detector’s parent directory.  

3) Source-to-detector distance: This is the distance between the detector and calibration sources. A 

value must be entered upon detector creation, but this value can be modified at any time if needed. 

The value is given in centimeters, but other units may be used (see Section 2.2). 
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Figure 3. File Drop-down Menu (top) for Create New Detector Dialog (bottom) 

New detectors may be created by clicking the Clone button located in the middle of the window or the 

Create button located at the bottom of the window. 
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1) Clone: An existing detector is copied using either the provided dropdown list or the Browse button. 

After choosing the appropriate detector, clicking the Clone button will create the new directory with 

the appropriate Detector.dat file.  

2) Create: This option generates a new Detector.dat file. Select the detector type (e.g. NaI, HPGe, etc.) 

from the dropdown list. The number of channels and the detector efficiency or detector dimensions 

should be entered. (Note: The Length dimension is along the line defined by the two points: (1) the 

center of the source and (2) the center of the front face of the detector. This is also referred to as 

depth. The height and width define the front face dimensions.) The user can then click the Create 

button to create the new directory with the appropriate Detector.dat file. 

 

GADRAS-DRF assumes a rectangular prism for the detector shape. If the detector’s front face is 

circular, enter the diameter in the width and height fields. With the cursor still in the fields, press 

the “d” key to convert each to a side length that preserves surface area. 

When creating an HPGe detector, the user can enter the relative efficiency of the detector 

compared to a standard 3×3 NaI detector at 1332.5 keV with a source-to-detector distance of 25 

cm. GADRAS-DRF will subsequently assign typical physical dimensions.  

Selecting None for the detector type will simulate a perfect radiation detector. Computed source 

spectra will be composed of the leakage current from the source and the solid angle of the detector. 

No peak broadening or any other physics associated with a real detector are applied.  

2.1.2 Copying an Existing Detector Response Function (Detector.dat) 

Detector.dat files for characterized detectors are contained in subdirectories under the primary 

detector directory “GADRAS-DRF\Detector”. Detectors may be copied using a Windows Explorer 

window. An existing Detector.dat file can be copied and pasted manually to a new directory to create a 

new detector parameter file that GADRAS-DRF will recognize as a valid detector.  

Note: It is advisable to always work with copies of distributed Detector.dat files as opposed to modifying 

the original. Working on original files may compromise them. Furthermore, each release and install of 

GADRAS-DRF will overwrite any changes to the original files. 

GADRAS-DRF expects spectral data files and the response function file (i.e. Detector.dat) to reside 

together in the same subdirectories of “GADRAS-DRF\Detector”. The main criterion for GADRAS-DRF to 

recognize a detector directory is the existence of a Detector.dat file. The application will not recognize 

multiple Detector.dat files in the same directory. 
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2.2 Detector Parameters in Detector.dat Files 

From the Detector tab, the detector response function parameters (as found in the Detector.dat file) 

can be accessed and edited. For example, these parameters are displayed in Figure 4 for a NaI detector. 

For other detector types, similar screens are displayed with some detector-specific variations. Response 

function parameters are grouped on the page and will be discussed using these headings. 

Dimensions and distances can be entered in the following units: centimeters, meters, feet, or inches. 

GADRAS-DRF will convert the user input to centimeters. The convention for entering alternative 

dimensions is to type an identifying letter after the numerical entry. The identifiers for meters, feet, and 

inches are “m”, “f”, and “i”, respectively. For example, to enter 12 inches as the distance, you would 

type “12i” into the distance entry box; unit conversion is performed automatically so that distance is 

displayed in centimeters after typing the character “i”. 

The following sections briefly describe the function of each field on the Detector tab. For more 

information, see reference [8]. 

 

Figure 4. Example Detector Response Function Parameters for a NaI Detector 

 



21 

 

2.2.1 Detector Dimensions 

The following parameters describe the detector dimensions: 

 Setback is the distance in cm from the physical surface of the detector face to the active sensor 

element (crystal). 

 Length is the detector length in cm measured perpendicular to the detector face and is also 

referred to as depth. 

 Width is the detector width in cm measured perpendicular to the incident photon flux and 

parallel to the floor.  

 Height/Width is the ratio of the two dimensions perpendicular to Length.  

Note: if describing a detector system with an array of detectors, these dimensions describe the size of 

one of the detectors. Use the Scalar parameter described below to add multiple detectors to a 

system. 

Although these parameters describe a rectangular detector, other geometries can be approximated 

using these dimensions. For example, a cylindrical detector oriented so that the axis is pointed 

toward the radiation source can be approximated by a square with the same surface area as the 

circle (i.e., height × width = πr2). The conversion between diameter and width can be performed by 

typing “d” after specifying the numerical value for the diameter. 

 Shape and Shape factor (S) are parameters that describe the distribution of path lengths 

through which incident radiation travels as it traverses the detector. The shape factor describes 

a continuous function that varies from about 3 for circular cross sections (e.g. radiations enters 

predominantly through side of a cylindrical detector) to about 100 for flat detector profiles (e.g. 

radiation enters through top or bottom of cylindrical detector). Figure 5 shows detector profiles 

for several values of S. Note that the detector shape can vary depending on the orientation of 

the radiation source with respect to the detector. In the case of a cylindrical detector oriented 

so that the radiation source is located on the axis of the detector, the value of S is about 100, 

which describes a flat profile. Alternatively, from the shape entry, the user can select one of 

three shapes (flat, circular, or custom) and the shape factor value will automatically be adjusted. 
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Figure 5. Detector Cross-section Profiles for Several Shape Factors 

 Dead Layer (mm) describes the depth of the inactive region between the contacts and the 

semiconductor in a solid-state detector. Typical values are a less than a few millimeters, 

depending on the manufacturing technique employed. This primarily affects low-energy 

intensities such as x-rays. 

 Scalar scales the total efficiency of the detector. This is typically used for detector system arrays. 

The other dimensions describe the size of one detector, and this field can be the number of 

detectors in the system. 

2.2.2 Peak Shape 

The full-width-at-half-maximum (FWHM) for photopeaks describes the width or resolution of the 

detector.  If detector energy resolution followed Poisson statistics exactly, the width of the peaks would 

increase as the square-root of energy. However, the resolution of scintillators is often dominated by 

effects associated with intrinsic nonlinearities. For semiconductor detectors, the resolution at the zero-

energy asymptote is limited by dark current. GADRAS-DRF uses an empirical form of the FWHM that 

uses as few parameters as possible to describe a wide variety of detectors: 

0.00

0.20

0.40

0.60

0.80

1.00

-1 -0.5 0 0.5 1

C
h

o
rd

 L
e

n
g

th
 /

 D
e

te
ct

o
r 

Le
n

g
th

Distance from Axis (r) / Radius (R)

S = 30

S = 10

S = 3

S = 1



23 

 

𝐹𝑊𝐻𝑀(𝐸) =

{
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                 𝐸 ≤ 661, 𝑟0 < 0

 (4) 

where 𝐸 is the photopeak energy in keV, 𝑟 is the percent resolution at 661 keV, 𝑝 is the FWHM energy 

power (unitless), and 𝑟0is zero-energy asymptote in keV. 

The following parameters on the Detector tab are used to calculate peak shape and resolution: 

 keV @ E->0 zero-energy asymptote of the FWHM in keV (can be negative) 

 FWHM @661 (%) (or keV @ 1332) is the percent FWHM of the photopeak at 661 keV (or for 

HPGe detectors, it is displayed as the width of the photopeak at 1332 in keV) 

 FWHM Energy power describes the rate at which the FWHM increases as a function of energy 

 Low-E Skew describes the magnitude of photopeaks’ low energy tails 

 High-E Skew describes the magnitude of photopeaks’ high energy tails 

 Skew Energy Power describes the rate at which the low-energy tail decreases  

 Skew Extent +/- describes additional skew range relative to the nominal range 

2.2.3 Lower Level Discriminator 

 LLD (keV): The lower-level discriminator of the detector (low-energy cutoff) in keV is 

represented by this setting. 

 LLD Sharpness: The simulated LLD is not a step-function; the slope of the simulated spectrum at 

the LLD is determined by this parameter. 

2.2.4 Miscellaneous 

 Ext. Annih. Magnitude describes the magnitude of annihilation photons (511 keV) produced in 

the vicinity of the detector. Annihilation inside the active detector area is modeled explicitly. 

However, if high-atomic-number materials are used in the detector housing, additional 

annihilation photons can be modeled with this parameter. 

 Ext. Beta Magnitude provides the ability to estimate the continuum produced by 

bremsstrahlung emission. A good first estimate for this parameter is 20. Note: Except for limited 

cases, a correction of this bremsstrahlung parameter is neither necessary nor advised. If a more 

accurate representation is required, a radiation transport calculation should be performed. 

 % Holes Trapped is used as an empirical term related to hole trapping by detectors such as 

CdTe. This parameter does not have quantitative significance. 
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 Frisch grid %: Frisch grids are used in conjunction with some CZT detectors. The percent of 

events that are recorded between Frisch grid electrodes is described by this parameter. Events 

recorded in this region can produce up to twice the apparent full energy because both electrons 

and holes are counted; whereas holes are excluded for interactions within the bulk material. 

2.2.5 Default Energy Calibration 

These define the default energy calibration to use when not available in a spectral file. Routine energy 

calibration is usually performed elsewhere in GADRAS-DRF. Adjusting the energy calibration is discussed 

in Section 6. 

These parameters are typically only used when simultaneously varying the energy calibration with other 

detector response parameters during a characterization for plastic scintillators with no photopeak 

definitions. 

The most common energy calibration convention is to use polynomial coefficients. These coefficients 

convert channel number into energy at the lower edge of the channel according to the following 

equation: 

𝐸𝑖 = 𝑐0 + 𝑐1𝑖 + 𝑐2𝑖
2 + 𝑐3𝑖

3 + 𝑐4𝑖
4 (1) 

where 𝑖 is the channel number (starting at 0), and 𝑐𝑛 is the 𝑛𝑡ℎ polynomial coefficient. GADRAS-DRF 

uses the convention defined as the FullRangeFraction in ANSI N42.42-2006, which represents energy 

calibration as follows: 

𝐸𝑖 = 𝑎0 + 𝑎1𝑥 + 𝑎2𝑥
2 + 𝑎3𝑥

3 +
𝑎4

1 + 60𝑥
 (2) 

where 𝑎𝑛 is the 𝑛𝑡ℎ polynomial term which corresponds to 𝑐𝑛 in Eq. (1), and 𝑥 is the fractional energy of 

the spectral range. 𝑥 ranges from 0 at the lower edge of the first channel and ends at 1 at the upper 

edge of the last channel. If the spectrum has uniform energy groups, 𝑥 = 𝑖/𝑛, where 𝑛 is the total 

number of channels. The offset terms are identical in these definitions (i.e., 𝑎0 = 𝑐0), and the higher 

order parameters are related as follows: 

𝑎𝑗 = 𝑛
𝑗𝑐𝑗 (3) 

The final term in Eq. (2), which addresses nonlinearity in the low-energy region, does not have an 

equivalent term in Eq. (1). However, neither 𝑎4 nor 𝑐4 is often applied, so this incompatibility is rarely 

important. 

There are a few general remarks about what values might be reasonable for the calibration of a 

detector.  
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 Order 0 in Energy (offset): should a small number (<100) either positive or negative  

 Order 1 in Energy (gain): should be a number close to the maximum energy scale of the 

detector in keV 

 Order 2 in Energy (quadratic): should be zero unless the detector is non-linear 

 Order 3 in Energy (cubic): should be zero unless the detector is highly non-linear 

 Low Energy: non-linear parameter for the low-energy region (usually zero) 

In general, it is advised to initially have values only for the gain and offset. For more information on how 

to calibrate spectral data, see Sections 3.3.4, and 6. 

2.2.6 Inner Attenuator 

This reduces the intensity of all incident radiation, including room scatter, before it passes into the 

active detector volume. This is useful in describing detector housing. 

 Atomic Number is the effective atomic number (AN) of the inner attenuator. This can be an 

average of multiple materials. 

 AD (g/cm2) is the areal density (in g/cm2) (density multiplied by thickness) is the thickness of the 

attenuator 

 Porosity (%) allows for an attenuator with incomplete coverage around the detector 

2.2.7 Outer Attenuator 

This reduces the intensity of all direct radiation, not including room scatter. This is useful for describing 

attenuation by a detection system placed in a large truck. The truck walls can be described by the outer 

attenuator. 

 Atomic Number is the effective atomic number (AN) of the outer attenuator. 

 AD (g/cm2) is the areal density (in g/cm2) of the outer attenuator 

 Porosity (%) allows for an attenuator with incomplete coverage around the detector 

2.2.8 Timing 

 Compute Pileup with this box checked, GADRAS-DRF will simulate pile-up effects from random 

coincidences in high-count rate simulations 

 Shape Time (us) is an empirical parameter to describe the shaping time of the amplifier. Since 

the amplifier shape time constant is generally only approximate, it is often necessary to 

characterize this parameter from calibration spectra. If the detector has a pileup rejecter, as 

most modern systems do, this field should be entered as a negative value, with a magnitude 

approximately equal to the shape time constant in microseconds. The value should be 

approximately -5 for typical HPGe detectors equipped with pileup rejection circuitry. 



26 

 

2.2.9 Shield / Collimator 

These parameters describe shielding on the sides and back of the detector in addition to the 

attenuators. This can also be used to add a collimator to the detector. 

Shielding materials are specified by specifying a % side shield parameter and a % back shield parameter. 

The % side shield is defined as the percent of the side of the detector that is surrounded by the shield. 

This will be set to 100 if the shield completely covers the sides but does not extend in front of the face of 

the detector. The length of the shield is described as a percent of the detector length, so collimators can 

be described by entering a value that is greater than 100%. For example, a value of 230 indicates that 

the length of the shield measured from the back of the detector to the front of the shield is 230% of the 

detector length (i.e., the shield extends 1.3 times the detector length in front of the detector). Similarly, 

% back shield is defined as the percent of the back of the detector that is surrounded by the shield. For 

collimators with an aperture less than the diameter of the active detector element, the Alt Collimator 

Diam field allows specification of the aperture size. 

2.2.10 Fluorescence X-rays 

Some detectors are constructed with high-atomic-number materials in the vicinity of the active volume 

which produce fluorescent x-rays in response to external radiation. This can also be used to describe the 

magnitude of the x-rays from a shield or collimator. 

GADRAS-DRF allows for two fluorescing Materials with respective Magnitudes. An approximate energy 

dependence is applied for these x-rays 

2.2.11 Coincidence / Imaging 

In some detector systems, the primary detector is surrounded by another detector, called an 

anticoincidence (AC) shield. This reduces background by rejecting events recorded simultaneously in 

both detectors. AC shields reduce the Compton continuum by excluding interactions where a photon 

scatters between the primary detector and the AC shield. The default setting is no AC shield. The effects 

of AC shields can be treated by defining the parameters under the Anti-Coincidence Shield section: 

 Type: The type of AC shield detector material (e.g. NaI) 

 Solid Angle: Solid angle subtended by the AC shield from the primary detector 

 Thickness: Thickness in cm of the AC shield 

 Dead Layer Z: Average atomic number (AN) of the dead layer on the AC shield 

 Dead Layer AD: Areal density of the AC dead layer in g/cm2 

 Shield LLD: Lower-level discriminator of the AC shield 

Note: these set of parameters will be used to describe imaging systems in future versions of GADRAS-

DRF. 
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2.2.12 Photon Scatter 

GADRAS-DRF includes a library of scattering kernels which are used to calculate scattering contributions 

from any surfaces present in the environment surrounding the source and the detector. The source-to-

detector distance and height determine the position of the source in a nominal room. The scattering 

magnitude is sensitive to height, so it is important that this parameter is accurate. The Clutter 

parameter determines the average distance from the detector to the walls in the room. The following 

guidelines can be used when determining initial scatter parameters: 

 Outdoors/Large Room should have a small Clutter term (less than 3). 

 Average Room should have a Clutter term equal to 3 (indicates an average distance of 3 meters 

to the surrounding walls in the room). 

 Small Room should have a Clutter term that is computed using the equation 900/{average 

distance to the walls in cm}. 

The scatter parameters labeled 0 Degrees, 45 Degrees, 90 Degrees, 135 Degrees, and 180 Degrees 

adjust the magnitude of the scattered radiation. The 0 Degrees parameter corresponds to low-angle 

scattering within the environment, which manifests itself as continuum just below the photopeak 

energy. The 180 Degree parameter corresponds to a photon which has backscattered in the 

environment and manifests itself in the backscatter peak. A value of 3 in these fields describes indicates 

that the observed scattering continuum in the detector is consistent with the external environment. 

Values may exceed 3 if additional scattering occurs within the detector housing. Setting the scatter 

terms to zero disables the computation of scattered radiation. 

 Rate @ E->Edge adds or subtracts continuum just below the Compton edge (less than 3 reduces, 

greater than 3 adds) 

 Rate @ E->0 adds or subtracts continuum as the spectrum approaches zero energy (less than 3 

reduces, greater than 3 adds) 

 Increase with E adds or subtracts additional scatter with increasing photon energy (less than 3 

reduces, greater than 3 adds) 

 Attenuate further reduces low-energy continuum  

For special environments (e.g., source and detector are not at the same height, or placed in a corner), a 

user can define an Environment.dat file in the detector directory. An example Environment.dat file is 

located in “GADRAS-DRF\Detector\3x3\NaI AboveSource”. 

2.2.13 Air Pressure 

The air pressure defines the density of intervening air and is only significant when the source-detector 

distance is greater than about ten meters. Air attenuation is determined by the atmospheric pressure 

(Air Pressure) or the Elevation fields. 
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2.2.14 Neutron Scatter 

Most gamma detectors are sensitive to neutron radiation. These parameters define the intensity of 

neutrons on the gamma detector: 

 Environment Drop-Down Box describes the reflection of neutrons in the surrounding 

environment, also called the room return. Options are “No reflected neutrons”, “Outside or 

large bay”, “Indoors above suspended floor”, and “Indoors above concrete on ground”. The 

neutron reflection is dependent on the distance and height parameters as well.  

 Thermal Stopped % is the percent of thermal neutrons that are stopped by exterior shielding 

around the detector sensor 

 Reflection Scalar directly scales the rate of neutrons reflected by the surrounding environment 

uniformly across all energies 

2.2.15 Computation Options 

These control options that aren’t necessarily part of the detector response, but may differ between 

detectors. 

The Weight Range area has two fields: Lower Limit and Upper Limit. During any analysis or fitting, 

GADRAS-DRF will attempt to fit only the region of the spectrum defined by these limits. Grayed-out 

regions in the plot indicate ignored portions of the spectrum and are not used in any analysis or fitting 

routine. 

 Default # Channels: When generating synthetic spectra, this defines the number of channels in 

the spectra. 

 Template Error (%) defines the assumed error with the simulated spectrum. This is used in the 

chi-square estimate. 

 Assume MCA Bins from Inbin: this checkbox toggles the usage of the Inbin.dat file. Inbin.dat 

defines relative channel widths and is useful for detectors with non-uniform channel widths. 

This checkbox is only enabled if Inbin.dat is present in the current detector directory. 

 Collapse Spectra to Rebin: this checkbox toggles the use of the Rebin.dat file. Rebin.dat 

contains a list of energy groups, usually less than the detector’s total channel count, to reduce 

computation time for certain analyses. This checkbox is only enabled if Rebin.dat is present in 

the current detector directory (users can use Rebin tool to generate Rebin.dat). 

2.2.16 Calibration Options 

The default detector configuration with respect to the measured source is described by the following 

parameters: 
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 Distance is the source-to-detector distance in cm measured from the center of the source to 

the center of the detector face.  

 Height is distance in cm above the ground. For most applications it is assumed that the detector 

and source are at the same height. 

 Replace Ecal in All Files: when the Default Energy Calibration parameters are varied in a 

detector response characterization, this box allows GADRAS-DRF to overwrite the energy 

calibration parameters in the files used with the default parameters. 

 

2.3 Detector Tab Menu Items 

2.3.1 File Menu 

As seen at the top of Figure 3, the File menu allows users to save the current detector parameters or to 

browse the detector directory. Clicking on Save Detector Changes or pressing Ctrl+S will save the 

current detector parameters to the Detector.dat file. If changes are made and the user attempts to 

navigate away from the Detector tab or attempts to close GADRAS-DRF without saving the parameters, 

GADRAS-DRF will prompt the user to save the detector parameters. Users may click Browse Detector 

Folder or press Ctrl+B (on any tab) to open a new Windows Explorer window for the current detector 

directory.  Users may click Recent Detectors or press Ctrl+R (on any tab) to open a form listing recently 

used detectors.  Users may select a detector from this form to quickly change detectors.  

2.3.2 Restore Points 

Restore points allow users to save the current detector response parameters. If users are trying to 

improve an existing detector response function but do not want to lose the original parameters, they 

may create a Restore Point. This is done by selecting Create New under the Restore Points menu item 

(Figure 6). If the detector parameters are adjusted incorrectly, they can be reverted to a set of previous 

parameters by clicking the appropriate Restore Point. 
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Figure 6. Restore Points Menu Item 

 

2.4 Detector Tab Calibrate Response 

To optimize the detector parameters click the Calibrate button at the bottom right of the detector page. 

This adjusts the parameters that the user has selected in order to match measured calibration spectra to 

computed spectra. To select a parameter for adjustment, users should click on the label of the 

parameter. Parameters that are highlighted in cyan have been chosen for adjustment. 

Calibration spectra are added to the SpecPair tree on the detector page (Figure 7) by dragging and 

dropping records from the PCF Viewer form (Section 3) into the tree. Users can add up to six SpecPairs 

to use in the calibration. Users should specify a Foreground and Background as well as a Source for 

Computed Spectrum. GADRAS-DRF will subtract the Background from the Foreground (using count rates 

in each energy bin) and compare the measured spectrum to the computed spectrum for the specified 

source. It will do this comparison for each SpecPair specified in the Calibration form. GADRAS-DRF will 

then vary the adjustable parameters and find the best parameter fit through non-linear regression 

iterations. 
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Figure 7. Detector Response Function Calibration Spectra 

 

To effectively calibrate a new detector to measured spectra, it is highly advised to determine the energy 

calibration and resolution before varying other parameters in the Detector tab. Users should also not 

attempt to vary all the parameters at once, as this may lead to degenerate solutions that do not reflect 

the best detector response parameters for a given setup. Users instead should vary energy and 

resolution parameters first, then attenuators and scattering parameters. Some parameters may be 

known prior to performing the Response Function Calibration (such as Shape Time or Shield Attenuator 

properties). In this case, users should put in the parameters before attempting any detector response 

function calibrations. 
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3 PCF SPECTRAL FILE  

3.1 PCF File Description 

The main file format intrinsic to GADRAS-DRF is a binary, direct access file with a PCF extension. 

GADRAS-DRF can read many other spectral file formats (e.g., Ortec CHN, IAEA SPE, ASC, PCC, N42, etc.) 

from many vendors and convert them to the GADRAS-DRF preferred PCF file format. GADRAS-DRF 

writes energy calibration coefficients and other supplemental information directly into PCF files.  

GADRAS-DRF generates and stores PCF files in the same file location as the Detector.dat file. This is 

typically a user-chosen subdirectory in “GADRAS-DRF\Detector”. The Detector.dat file must be defined 

prior to evaluating spectral data. Selection or creation of the detector (Detector.dat file) is discussed in 

Section 2.1. A PCF data file can be generated or created from the Plot tab on the main screen. To do 

this, the user can select New from the File drop-down menu, as shown in Figure 8. This action opens a 

Windows Explorer window with “eventList.pcf” as the default file name for the PCF. This file name can 

be modified by the user if desired. The default location is the current detector directory. Once the file 

name is chosen, the PCF Viewer will display a blank PCF file as shown in Figure 9. 

 

Figure 8. Creating a New PCF File From the Plot Tab Within the File Menu 
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Figure 9. Newly Created PCF Shown in the PCF Viewer 

Spectral files of almost any format can be added to the blank PCF by dragging and dropping the desired 

data file to the gray area in the PCF Viewer. Figure 10 shows the file list form after populating the PCF 

file with eight spectral entries (five calibration source spectra and three background spectra).  

GADRAS-DRF can process spectral data taken at different source-to-detector distances and heights. 

Processing the spectral data is facilitated by entering the source-to-detector distance for each spectrum 

in the file title field so that these values are entered as defaults when computed spectra are compared 

with measurements. The source-to-detector distance must be contained between the character “@” 

and the string “cm” or “m,” indicating distances in centimeters or meters, respectively. The 

interpretation of the string defining distance is not case sensitive. If the detector height is also entered, 

the height must be contained between the string “H=” and the string “cm” or “m.” Similarly, the strings 

are not case sensitive. For example, a spectrum taken at a height of 20 cm and a source-to-detector 

distance of 50 cm can have the following string in the Title “@ 50 cm H=20 cm”. Figure 10 shows the PCF 

Viewer with the “Th-228 @ 122 cm” entry highlighted in blue and a spectral preview on the right in red.  
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Figure 10. PCF Viewer with Spectrum Records Added 

3.2 Editing PCF Files 

The PCF Viewer edits the contents of a PCF file. Each entry or row in the PCF Viewer is a spectrum 

(record) stored in the PCF file. Editing cells in this table immediately edits and saves the contents of the 

PCF file. Editable fields include Tag, Title, Source, Date & Time, TL (live time), TT (total time), N (neutron 

count rate), Offset, Gain, Order 2, and Order 3. Not all fields are visible by default. Users can modify 

which columns are visible using the Select Columns to Display under the Options menu. 

The top of the PCF Viewer form contains shortcuts and fields with various functionality. From left to 

right they are: 

   Create a new PCF file 

   Open a spectrum file 

   Print record header information 

   Choose which columns are visible 

   Display spectrum preview thumbnail 

   Peak search energy calibration 

 Ecal:  This displays the energy calibration for all records in the top menu bar, if the energy 

calibration is the same for each detector (by default there is only one detector). If the energy 

calibration for one record changes, this editor will disappear. 

    Display/hide energy calibration columns 
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3.3 PCF Viewer Menu Items 

3.3.1 File Menu 

Under the File menu, the Open option loads an existing PCF file; the New option creates a new one; the 

Import File has the same effect as dragging and dropping spectral files into the viewer to add them; the 

Print command sends the contents of the PCF Viewer window to a printer. 

3.3.2 Edit Menu 

Each record in the file has its own energy calibration parameters (except for Deviation Pairs). The Energy 

Calibration for All Records (Figure 11) option allows users to modify all records simultaneously. 

 

Figure 11. Edit Energy Calibration for All Records Editor 

The Deviation Pairs menu option brings up the Deviation Pair Editor form, which is discussed in Section 

6.3. 

Reformat All Titles allows users to normalize their title formats for large files quickly. It searches for 

Distance, Height, and Detector Name information and reformats them to a standard. 

Update with .lis file imports a file formatted in the .LIS format (normally exported header information 

from a PCF into the GADRAS-DRF Temp folder), and overwrites the current file’s header information 

with information from the .LIS file. 

If users inadvertently change a field in the PCF file, they can choose Restore to Last Backup in the PCF 

Viewer’s Edit menu. 
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3.3.3 Options Menu 

Users can modify which columns are visible using the Select Columns to Display under the Options 

menu. The Options menu also has an option to toggle the spectrum preview window on the right side of 

the PCF Viewer. 

3.3.4 Calibrate Menu 

3.3.4.1 Peak Search Calibration All Records 

By selecting this option, the Peak Search and Manual Energy Calibration form appears (shown in Figure 

12, left). A user can then drag and drop a record (row) from the PCF table into the blank portion of the 

Peak Search window. The zooming functionality on this plot is similar to the mechanism for normal 

plots. Users can click-and-drag right over regions of interest to zoom in. To zoom out, click-and-drag left. 

To include a peak in the fitting routine, the user should click a visible peak in the displayed spectrum. 

Peaks recognizable by GADRAS-DRF for this procedure are shown in green above a red continuum with 

the default 5 sigma peak threshold, as shown in Figure 12 (right). 

 

Figure 12. The Peak Search and Manual Calibration Screen is Blank When First Opened (left) and 
Populated When a Spectrum is Loaded (right) 

The Peak Threshold (sigmas) option can either be lowered to recognize additional peaks or raised to 

recognize fewer peaks. For the new peak threshold value to take effect, it may be necessary to reload 

the spectrum by dragging the file to the window. Clicking a recognized peak will open a window to 

specify the energy of the peak as shown in Figure 13. If the centroid energy is close to a known peak for 

an isotope included in the GADRAS-DRF library, the isotope will be displayed along with the determined 

gamma-ray energy. Other peaks and energies around the determined value are also listed. The initial 

peak energies are based on the current energy calibration parameters existing for the detector. Users 

may select the appropriate isotope and energy in the provided list, or they may manually enter the 

appropriate energy for the isotope. Clicking OK assigns the Actual Energy selected to the channel 
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number in the spectrum. This process can be repeated for any number of available peaks in the 

measured spectrum as needed to complete the channel/energy table.  

 

Figure 13. Users Select the Energy of the Peak From the Popup Window, or may Manually Enter the 
Known Energy 

For high-precision spectra (e.g., HPGe spectra), a region of interest (ROI) of the graph can be selected by 

dragging to the right over the ROI. Dragging left will zoom out the display. Individual peaks may be 

easier to identify and select in the new ROI.  

After entering an appropriate number of peaks in the channel/energy table, the energy parameter 

adjustment can be performed. The upper-left portion of Figure 14 displays the two energy peaks that 

were selected for energy calibration (channel/energy table) and the upper-right portion displays the 

Adjust Parameters tab. The highlighted (cyan) parameters will be adjusted. After the peak selection 

process is complete and the appropriate parameters are adjusted, the user should click the Fit 

Parameters button below the parameter group boxes to initiate the least-squares fit to the data.  
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Figure 14. Energy Calibration Screen Showing the Selected Peaks and the Highlighted (cyan) 
Parameters that will be Adjusted (center) 

To ensure a proper energy calibration, a small subset of well-known peaks should be selected. GADRAS-

DRF will then properly assign energies for subsequent peak selection. 

It is usually advisable to use Order 0 and Order 1 for an initial energy calibration, and then to include 

higher orders if the fits are not acceptable. The Order 1 energy parameter should be approximately 

equal to the full scale energy value of spectrum in keV (e.g., 1500, 3000, 11000) depending on the 

detector. In general, small values are common for Order 0, 2, and 3 energy parameters. Once the energy 

offset and gain (Order 0 and Order 1) parameters are adjusted correctly, the energy resolution 

parameters (low/high-E skew) should be adjusted.  

3.3.4.2 Linearize All Records 

This option uses the energy calibration from each record, along with any deviation pairs defined, to 

determine the energy bounds of each channel of each record. It then rebins all records into a linear 
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channel-group structure, such that the calibration is defined only with a gain term (zero offset). The 

deviation pairs in the file are erased. 

3.3.4.3 Calibrate and Linearize All Records 

This option, in addition to the linearize option, attempts to automatically calibrate each spectrum. This 

can be done for each record based on the 2614 keV peak, 1460 keV peak, or based on each records’ Tag 

character. The following Tag characters are acceptable in this context: 

 T only adjust gain based on 2614 keV  peak 

 t adjust gain and offset based on 2614 keV peak and 239 keV peak (use 583 keV peak if 

available) 

 K only adjust gain based on 1460 keV peak 

 

3.3.4.4 Automatic Energy Calibration 

This tool searches the entire spectrum for common background peaks, and fits the energy calibration 

parameters, resolution parameters, and skew parameters automatically. It gives users the option to 

write the fitted parameters to all records in the file, or just the one that was used to search for 

background peaks. 
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4 PLOTTING/VIEWING SPECTRA 

4.1 Measured Spectra 

Users can plot one or more gamma-ray spectra in a PCF file using the Plot button located on the bottom-

right corner of the Plot tab (Figure 15). 

A record of interest from a PCF file can be plotted by dragging and dropping an entry from the PCF 

Viewer to the Foreground text box or to the plot table that lists current Spectral Pairs. The plot table 

consists of three columns. The first column is the Title of the SpecPair, which is the title of the 

Foreground spectrum if present. If the Foreground is absent, the Title will be the Computed Spectrum 

name. If this is absent, the Title will be “Unknown” and will not be included in the plot display. The 

second column is the File associated with the SpecPair. This will be the foreground spectrum file name 

and record, or the computed source file name if the foreground textbox is blank. The third column 

specifies the background associated with the SpecPair. A spectrum specified in the Background textbox 

is time-normalized to the current foreground spectrum and is subtracted from the foreground before 

being displayed on the Plot tab. Clicking the Plot button will display the desired background-subtracted 

spectra. Figure 16 shows a plot of a 228Th spectrum. 

 

Figure 15. Plot Tab with Entries to be Plotted From the “Cal.pcf” File 
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The Add SpecPair and Delete SpecPair buttons in the middle of the screen are used to add or remove 

spectra from the drawn plot. When the Add SpecPair button is clicked, GADRAS-DRF adds the 

subsequent record from the current PCF file to the Foreground spectrum. The previous Background 

record is maintained by default. If the previous Foreground record was the last record in the PCF file, 

the same foreground is added to the table again. 

 

Figure 16. Plot of Background Subtracted 228Th Spectrum 

 

Figure 17 shows a plot with three spectral pairs selected for graphing. These pairs are displayed in the 

central white area of the Plot tab. Up to six spectra can be selected and displayed in a single graph.  
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Figure 17. Plot Tab Example with Three Background-Subtracted Spectral Pairs 

Figure 18 shows the graph of the three spectral pairs identified in Figure 17. The graphs are identified 

for each spectrum by the color selected in the style box in the Plot tab. The 88Y is displayed in a dark blue 

line as shown in the style box in Figure 17. 
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Figure 18. Plot of the Three Background-Subtracted Spectral Pairs: 228Th (black), and 88Y (blue), and 
137Cs (cyan). 

4.2 Plotted Spectrum Window 

After the plot is displayed, navigation can be done with the mouse. Drag from left to right to zoom-in on 

a region of interest as shown in Figure 19. Drag from right to left a small amount to partially zoom out. 

Drag from the right to left a larger amount to completely zoom out. Use the mouse wheel if available to 

change the number of log cycles displayed, or to switch between linear and logarithmic scales. Other 

graph navigation options can be set from the Setup tab. 
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Figure 19. Zooming-in on a Plotted Spectrum 

 

The top of the plot window shown in Figure 19 contains shortcut buttons and additional options. 

Starting from left-to-right, they are: 

   Save the computed spectrum to file 

   Reset the zoom (zoom out completely) 

   Enable/disable peak search mode 

 SE  Show the single-escape line (see Figure 20) 

 DE  Show the double-escape line (see Figure 20) 

 C  Show the location of the Compton edge (see Figure 20) 

 E-Min / E-Max: These are default limits of the plot in keV. 

 Channel Number or Energy (keV): This drop-down box allows users to view both channel 

number and energy, or just energy units on the x-axis 

 Counts/keV or Counts/Channel: This drop-down box changes the normalization factor for the 

channel bins (normalize by energy, or normalize by channel). 

 Log Cycles or Square Root or Linear: This drop-down changes the scale of the y-axis. This scale 

can also be modified with the mouse-wheel. 
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On the left-hand side of the plot window is a collapsible panel containing additional plot options. From 

top-to-bottom, they are: 

 Energy Calibration: These options modify the behavior of graphical energy calibration (see 

Section 6.2 for more detail on graphical energy calibration). The drop-down box specifies which 

spectra are to be modified (each record in a spectra file has its own coefficients). By default, all 

records from all files plotted are modified. Users can choose to only modify all the spectra that 

are plotted, or an individual spectrum plotted. The ability to modify the energy calibration of a 

single spectrum from a file is useful if there is gain or offset drift between measurements. 

 

Under the drop-down box there is also two button to select whether the energy calibration 

coefficients for the foreground and subtracted background are to be modified (default), or just 

the foreground. 

 Display Options: The first drop-down box has three choices to display how spectra are plotted 

(note this only has an effect on line-style plotted spectra, not on “error-bar” style plotted 

spectra). The options are Curve (Default), Histogram, and Bar Chart. 

 

The second drop-down box controls the grid on the chart. By default, only the x-axis and y-axis 

at zero are plotted (Zero Crossings). Users can turn off all grid lines (No Grid), or shown them 

throughout the chart (Dotted Grid).  

 Misc: The first drop-down box contains smoothing options. The default is to display at most 

1024 channels. However, if a user zooms in to a region that has less than 1024 channels, no 

rebinning is done and all channels are displayed. Other options include 512 channels, Smooth 

Magic, Smooth by FWHM, No Smoothing (display all channels), and a variety of smoothing 

options by percent of energy. These only affect how the spectrum is viewed, not any analysis or 

computations. 

 

The default true-time is only used when only a computed source or calibration source is plotted 

without a foreground (from which the true-time is extracted). 

 

4.2.1 File Menu 

The File menu consists of the following options:  

 Copy to Clipboard copies the plot screen to the clipboard as an image and can be pasted into 

another application 

 Write Computed Spectrum to File saves the computed spectrum to a pcf file for future plotting 

 Save to Metafile saves the plot screen to an image file (.emf) 

 Print: allows users to print the displayed graph 
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4.2.2 Tools Menu 

The Tools menu provides options for graph properties, peak lists, and count rates:  

 Zoom to Extents: zoom the graph out to the full energy limits 

 Count Rates: provides the count rate for each of the graphed spectra at the currently displayed 

energy limits 

 Peak Search Mode: provides energy and count rates for peaks in the spectrum in graphical and 

list form 

 Edit Deviation Pairs: allows the user to view and edit the deviation pairs associated with the 

current spectrum 

 Show Peak List: displays a list of peaks that can be overlaid on the spectrum; by selecting an 

entry, all peaks from the specified source and threshold will be displayed (this option is 

discussed in more detail in Section 6.1.1). 

 Show Isotope DB: displays the Isotope Database for use in analyzing displayed spectra 

(discussed in Section 6.1.2) 

4.2.3 View Menu 

The View menu allows users to display common features of a plot using the cursor. When users select 

any of Single Escape, Double Escape, or Compton Edge, the cursor location on the spectrum is used as a 

starting point and energies of the specific features are calculated and displayed on the screen (Figure 

20). 
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Figure 20. Spectral Features from View Menu 

 

4.3 Source Wizard and Computed Spectra 

Besides displaying measured spectra, GADRAS-DRF can also display computed spectra or isotope source 

spectra. Sources for computed spectra are entered on the Source for Computed Spectrum entry at the 

bottom of the Plot tab or by using the Source Wizard button.  

4.3.1 Source Wizard 

The Source Wizard button shown in Figure 17 is located just below the Simulated or Calibration Source 

entry. The Source Wizard form is shown in Figure 21. 
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Figure 21. Source Wizard Screen 

The drop-down menu in the source wizard allows users to select various types of sources, such as 

radionuclides and distributed GAM files. Users can use the arrows in the center of the window to add or 

remove sources from the current list of Included Sources. The third column on the far right of the Source 

Wizard allows users to edit the GADRAS-DRF shorthand notation for shielding. After clicking OK, the 

Source Wizard will automatically generate the GADRAS-DRF shorthand string in the Computed Spectrum 

text box. 

4.3.2 Simulated or Calibration Source 

In lieu of using the source wizard button, the user can enter source information on the computed source 

line. 

Sources may include: 

 the name/serial number of a calibration source in the source library/database,  

 distributed GAM files, and 

 an isotopic designation and source strength (e.g., 232U, 1.5uC).  

Activity units for the computed spectrum are always given in Curies (shortened to “C” instead of the 

standard “Ci”). This unit may be prepended with the following SI prefixes (Note: these are not case 

sensitive): 
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 pC: picoCuries 

 nC: nanoCuries 

 uC: microCuries 

 mC: milliCuries 

 kC: kiloCuries 

Alternatively, Becquerel units can be input using the following SI prefixes (also not case sensitive):  

 kBq: kiloBecquerel 

 MBq: megaBecquerel 

 GBq: gigaBecquerel 

Mass or activity of a source can be specified and used for plotting. The mass is converted to the proper 

activity prior to plotting (e.g., 239Pu, 50g is converted to 239Pu, 3.1C).  

When GAM files are used, the activity level specified in Curies determines the scaling factor for the 

source. Thus, an activity of “1C” indicates that the source should not be scaled, and an activity of “2C” 

indicates that the source strength should be doubled. 

The simulated/computed spectrum can be a mixture or sum of several spectra. The individual spectra 

can be summed by placing a plus (+) sign between the successive sources (e.g., 232U, 1uC+40K, 25mC). 

Gamma-rays emitted by the specified isotopes are folded through the detector response function to 

compute the spectrum that would be recorded if the detector were exposed to the given sources. If one 

spectral pair is plotted, the reduced χ2 fit residuals between the measured and computed spectra are 

calculated and displayed.  

4.3.3 Viewing Spectra 

Figure 22 shows the Plot tab with a 88Y spectrum (cal.pcf, 3) on the foreground line and a background 

spectrum (cal.pcf, 1) on the background line. The Source for Computed Spectrum line shows that the 

measured spectrum is to be compared with the computed spectrum for the 88Y source with serial 

number 495182 entered as 88Y_495182.  
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Figure 22. The Plot Tab Displaying Selections for a Foreground, Background, and Computed Spectrum 

Figure 23 is generated after the Plot button is clicked. The measured 88Y spectrum (background 

subtracted) is displayed in black, while the computed spectrum for the 88Y source (ID number: 495182) 

from the source library is displayed in red. The count rate is displayed at the bottom left of the graph for 

all graphed spectra for the displayed energy region. The count rates are color coded to match the color 

of the corresponding spectrum.  
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Figure 23. Plot of a Measured 88Y Spectrum (background subtracted) and the Computed Spectrum 
from 88Y Calibration Source 

Computed sources may be plotted by themselves by using the Source for Computed Spectrum line 

without a measured spectrum on the foreground or background lines. If desired, effects of shielding 

materials can be estimated by specifying the material on the Source for Computed Spectrum line. The 

atomic number and areal density of the absorbing material can also be entered on the input line using 

the following convention: 

232U,10uCi {26,10} + 137Cs,3.2mCi {13,5} 

In this example, 10uCi of 232U is propagated through 10 g/cm2 of iron (Z=26), and 3.2mCi of 137Cs is 

propagated through 5 g/cm2 of aluminum (Z=13). This functionality is also accessible from the Source 

Wizard form, described in Section 0. 
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5 COUPLING GADRAS-DRF TO EXTERNAL RADIATION 

TRANSPORT CODES 

To accurately model non-point sources or sources in complex scattering environments using GADRAS-

DRF, an external code must be used to perform the radiation transport calculations. Radiation transport 

codes such as the Monte Carlo N-Particle (MCNP) code, developed by Los Alamos National Laboratory, 

can be used to model sources and scattering environments. The output from these codes can be used 

with the detector response function in GADRAS-DRF to model 3-dimensional sources or complex 

scattering environments. This section describes how users should set up the radiation transport codes 

(specifically MCNP) to use with GADRAS-DRF. Users may also elect to use other codes such as GEANT, 

PARTISN, DENOVO, or custom user codes. 

GADRAS-DRF calculates the detector response for radiation directly incident on the detector as well as 

for radiation that has scattered in the environment before interacting with the detector. To calculate the 

scattered radiation, GADRAS-DRF has several scatter parameters which simulate a general scattering 

environment. If the scattering environment is complex, external transport codes can be used to 

calculate the incident radiation instead of GADRAS-DRF. To do this, MCNP should be used to model the 

radiation current separately on multiple facets of the detector. Using the MCNP results, GADRAS-DRF 

can compute gamma-ray spectra and neutron count rates for a given scenario. These results may have a 

higher degree of fidelity than can be obtained by applying the default scatter parameters. If a source 

cannot be approximated with a point source, MCNP can be used to calculate the radiation transport 

from the source to the detector with a higher degree of fidelity than GADRAS-DRF alone. 

The MCNP scenario should be designed to simulate the external scattering environment and tally the 

energy-dependent current on each surface of the modeled detector. The output files should then be 

converted into files that are compatible with GADRAS-DRF. These input files are called “multi-faceted 

GAM files.” GADRAS-DRF processes these multi-faceted GAM files by calculating the detector response 

from the radiation that scatters within the detector housing, and assuming that MCNP has accounted for 

the external radiation scattering. 

To correctly process multi-faceted data generated by MCNP, users need to suppress GADRAS-DRF’s 

external scatter radiation calculations by setting all of the scatter parameters to zero (Figure 24). The 

radiation transport code must tally photons and neutrons that scatter into the detector from the floor, 

walls, ceiling and any other object in the detector’s vicinity; GADRAS-DRF will account for radiation 

scatter within the detector. 



54 

 

  

Figure 24. Set all Scatter Parameters to 0 When Using Multi-faceted GAM Files 

  

5.1 MCNP Methodology 

To compute the detector surface currents for a given scenario, the MCNP model should contain a 

cylindrical volume representing the detector. The cylinder should be positioned at the detector location 

with dimensions similar to those of the detector. The current tally (F1) should be used to tally the 

photons and neutrons that cross each individual surface (front, back, sides). The pulse-height tally (F8) is 

not appropriate for use with GADRAS-DRF, as this tally represents the detector response function 

generated by MCNP and cannot be readily converted to a format that is usable by GADRAS-DRF. The 

current tally should be generated with the energy bin structure provided with the GADRAS-DRF 

distribution in the “MCNPbins.dat” file, (energies in this file must be converted from keV to MeV for 

usage in MCNP). Figure 25 below shows a simple example of a 127Cs source 1 meter away in air. A 

photon importance of zero in the detector cell ensures that the tally does not double-count particles 

that pass through the detector volume. 
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Figure 25. A Simple MCNP Input Deck 

The MCNP output file needs to be converted into a format usable by GADRAS-DRF. The tally from MCNP 

should be converted into surface current density (particles/m2s) for each energy bin. To do this, the 

source activity, particles per decay, and detector facet surface areas must be known. Figure 26 below 

shows an example of the necessary unit conversion for a 1 uCi 137Cs source counted with a cylindrical 

detector (r=10cm, l=10cm). Once converted to the appropriate units (particles/m2s), the current 

densities can be incorporated into the GADRAS-DRF multi-faceted GAM file.  

 

Figure 26. Pseudo-code for Scaling MCNP Surface Current Outputs to Units Suitable for use with 
GADRAS-DRF 

Figure 27 below shows an example of a multi-faceted GAM file with current densities for the three 

facets of a detector. GADRAS-DRF represents detectors as if they are symmetric normal to the detector 

axis, so there is no distinction between the top, bottom, left, and right sides. The average current over 

all the lateral sides of the detector should be specified as the third parameter on each line. 

Simple Example Input Deck 

1 0 -1 imp:p=0 $ detector volume 

2 1 -0.0012 -2 1 imp:p=1 $ surrounding air 

3 0 2 imp:p=0 

 

1 rcc 100 0 0  10 0 0  10 $ detector surfaces 

2 so 1000 $ universe sphere 

 

mode p 

sdef par=p pos=0 0 0 erg=0.6617 

m1   7014 -75 $ air 

     8016 -25 

f1:p 1.1  $ side of cylinder, side of detector 

f11:p 1.2 $ bottom of cylinder, front face of detector 

f21:p 1.3 $ top of cylinder, back face of detector 

e0 {insert values from MCNPbins.dat} 
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Figure 27. Multi-faceted GAM File Example 

In Figure 27 above there are NG + 1 lines for the photon groups and NN + 1 lines for the neutron groups 

where NG and NN are the number of photon and neutron groups respectively. For multi-faceted GAM 

files, there are always 0 discrete photons specified. The leakage values are specified in units of inbound 

current density (particles/m2s, current divided by surface area) on each detector surface. GADRAS-DRF 

accounts for the surface area of each detector facet when the response function is computed for a given 

detector. As a result, the same GAM file may be used to compute a response function for a different 

detector if it is situated at the same height and distance to a radiation source. 

The multi-faceted GAM file should be saved as <filename>.GAM, where <filename> is the user’s chosen 

file name. This file can then be included on the computed source line for plotting. 

Format specification (5 

signifies multi-faceted 

current data) 

 

0 discrete photons 

(always); 

 1,475 photon groups; 

78 neutrons groups 

    

Energy (keV-

photons, eV-

neutrons) at 

lower (photon) 

or upper 

(neutron) 

bound of 

energy group 

Current density 

(particles/s/m
2
) 

incident on front 

surface 

Avg. current 

density incident 

on side surfaces 

Current density 

incident on back 

surface 

Last photon group 

First neutron group 
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5.2 Automatic Conversion from MCNP Output to GADRAS-DRF Input 

GADRAS-DRF is distributed with python scripts that will convert MCNP output files into GADRAS-DRF 

input files. These scripts are located in the GADRAS-DRF data folder (usually C:\GADRAS-DRF), and are 

called “mfgf.py” and “mcnpfunc.py”. Users can view and modify “mcnp_example.py” to use these 

scripts properly. Currently only photons are included in the mcnp_example.py file. 

To use these scripts, the MCNP model must be configured to create a MCTAL file as part of its output. To 

do this, the line “PRDMP J J -1” must be included in the data card of the MCNP file. The python scripts 

need several inputs to properly generate a multi-faceted GAM file for use with GADRAS-DRF. Users must 

supply: 

 MCNP MCTAL file 

 Source activity (in Bq) 

 Source yield (particles per decay) 

 Area of face of detector in MCNP model (in m2) 

 Area of side of detector in MCNP model (in m2) 

Users must also install python on their computer and make sure the numpy library is present. To run the 

script, users should type “python mcnp_example.py” into the command prompt. 
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6 SPECTRUM ENERGY CALIBRATION 

There is a variety of methods in GADRAS for energy-calibration. Section 3.3.4 covers how to calibrate 

from the PCF Viewer by automatic methods as well as peak-search methods. The most common method 

to quickly calibrate a spectrum is through the Plot window. 

6.1 Helpful Tools for Energy Calibration and Peak Analysis 

6.1.1 Photopeak List 

To aid in performing an energy calibration or in determining a peak’s energy in a spectrum, the 

PhotoPeak List library can be used. This list can be accessed: 

 From the Tools tab 

 Using the mouse (shift+left mouse click (holding down the shift key while clicking the left mouse 

button)) on a peak of interest in a displayed spectrum 

 From the Plot window under the Tools menu, Show Peak List 

The PhotoPeak List library is shown in Figure 28. The blue highlighted entry corresponds to the gamma-

ray automatically selected by GADRAS-DRF based on its proximity to the selected energy location on the 

current plot (shift-left click location). The selection also takes into account the relative importance of the 

gamma-ray to the observable spectral features.  
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Figure 28. PhotoPeak List Library with 88Y Highlighted and Both Overlay Options Boxes Checked 

At the top left of the PhotoPeak List library screen are two check boxes for overlay options. The overlay 

fit check box when selected will generate a spectral overlay fit for the selected isotope (a single 

regression fit using one isotope). The spectral overlay displays the source activity and shielding 

configuration estimated to provide the best fit to the measured spectrum. The overlay lines check box 

overlays vertical lines at the appropriate energy locations for the selected isotope on the measured 

spectrum utilizing the Max Lines to Plot selection. The displayed overlay can be changed to display 

another isotope simply by selecting and highlighting another gamma-ray line in the PhotoPeak List, 

allowing for rapid examination of many isotopes in the library. The color and line thickness of the 

overlaid spectrum can be changed using the options at the top of the library window. The selections 

displayed in the PhotoPeak List in Figure 28 are shown in the displayed graph in Figure 29. 
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Figure 29. Graph Displays the Measured 88Y Spectrum (black) with Both Overlay Options 

The graph in Figure 29 displays the measured 88Y spectrum (black) along with both overlay options. The 

overlay fit option generates a spectrum which is cyan in color and has a thickness value of three. The 

overlay lines option displays the lines and their energies. 

6.1.2 Isotope List 

Another useful tool when graphically calibrating is the Isotope Database tool (shown in Figure 30). 

Instead of selecting a peak from a plot, the drop-down menu at the top of this tool allows users to 

choose a radionuclide from the list, and overlay lines and a fit to the current plot window. This can also 

be used as a reference for emitted radiation from common radionuclides. 

The graph in the center of the form shows the locations of the main photopeaks for the selected 

isotope. The center of the window displays properties for the selected isotope such as isotope 

designation, half-life, age, and specific activity. It also specifies if the nuclide is assumed to be in prompt 

or secular equilibrium with its daughters. The bottom of the window displays characteristic gamma-ray 

energies sorted by intensity multiplied by the square-root of the energy. 

If a spectrum has been plotted, users can display overlays of the nuclide on a current plot using the two 

Overlay checkboxes located at the top of the Isotope DB form. The first checkbox overlays a graphical fit 
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of the selected isotope by automatically calculating the activity and shielding to best match the 

measured spectrum. The overlaid spectrum is generated using the detector response function 

parameters found in the Detector.dat file. The user may also change the color and line thickness of the 

overlaid fit. The second checkbox overlays vertical lines on the plotted spectrum, which correspond to 

the major energy lines of the selected isotope. The number of lines to display can be changed by the 

user. 

GADRAS-DRF developers commonly list gamma-ray emissions from daughter radionuclides in the 

gamma-ray emission list for the parent radionuclide. This generally occurs if the daughter radionuclide is 

traditionally observed to be in equilibrium with the parent. For example, gamma-ray emissions arising 

from the decay of 208Tl are also listed under 232Th. The origin of a gamma-ray can be observed in the 

Source column of the table. 

 

Figure 30. Isotope Database Form 
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6.2 Graphical Energy Calibration 

A graphical calibration method is an alternative to using the Peak Search and Manual Energy Calibration 

process. This can be used for the adjustment of the gain and offset (Order 0 and Order 1) of the 

spectrum. The calibration will occur using a graph of the measured spectrum and the appropriate 

overlaid spectrum from the PhotoPeak list or Isotope Database library. Figure 31 (top) shows a 

measured 137Cs spectrum (black) and a library 137Cs spectrum (red). This plot is zoomed in to the region 

around the primary 137Cs peak at 661 keV. The measured spectrum (black) does not coincide with the 

energy of the library peak (red). This implies that an energy calibration of the data (measured spectrum) 

is needed.  

To calibrate the measured spectrum correctly, the centroid of the measured peak (black) should be 

adjusted to match the centroid of the computed spectrum (red). To make this adjustment, the user 

should right-click on the peak in the measured spectrum and drag the peak to the correct energy (the 

centroid of the peak in the computed spectrum). After right-clicking the plot window will be outlined in 

red as shown in Figure 31 to indicate energy calibration mode. Figure 31 (bottom) shows what the plot 

looks like after dragging the measured spectrum to the left (while still holding down the right-mouse-

button). 

Release the right-mouse-button to complete the action (or press escape to cancel it). Once this action 

has been performed, the energy calibration window shown in Figure 32 will appear for the selection of 

the appropriate calibration parameter (offset or gain). The user will need to confirm the adjustment 

before the energy calibration parameter will be changed. 
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Figure 31. Graphical Energy Calibration Example 

 

 

Figure 32. Graphical Energy Calibration Confirmation Window 

Due to the potential for inadvertent changes to calibration parameters, GADRAS-DRF requests 

confirmation for the parameters to be adjusted when the dragging operation is used. If a gain 

adjustment is made within thirty seconds of an offset adjustment, GADRAS will use both changes 

simultaneously to fit the gain and offset. The quadratic option is only available once the following 

criteria have been met: 

1. Successful gain adjustment within 30 seconds 

2. Successful offset adjustment within 30 seconds 
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3. The third adjustment energy is greater than 400 keV 

4. The adjustment energy is greater than 0.4 times the full-energy-range away from the energy 

used to adjust the offset 

5. The adjustment energy is greater than 0.4 times the full-energy-range away from the energy 

used to adjust the gain 

For example, if calibrating off of a background spectrum, and the 239 keV peak (Th chain), 1460 keV 

peak (K-40), and 2614 keV peak (Th chain) are visible, the user could drag the measured spectrum at 239 

keV to adjust the offset, the 2614 keV to adjust the gain, and then the 1460 keV to adjust the quadratic 

term. However, if the user tries to use the 583 keV peak (Th chain) to adjust the quadratic term, 

GADRAS-DRF will not allow a quadratic adjustment because it is too close to the 239 keV peak. 

If all the criteria are met, GADRAS-DRF will utilize all three energy adjustments to determine the offset, 

gain, and quadratic terms.  

Figure 33. Successful Graphical Energy Calibration displays the successful completion of the graphical 

energy calibration for the measured 137Cs spectrum to the computed spectrum. 

 

Figure 33. Successful Graphical Energy Calibration 
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6.3 Deviation Pairs Energy Calibration 

Scintillator detectors often require at least a quadratic polynomial to describe the relationship between 

the channels and energy. Some even require fourth-order polynomials and still have substantial error in 

the energy calibration. Deviation pairs are a method to describe highly non-linear detectors, or to 

describe the energy calibration exactly for detailed analyses. 

Deviation pairs can be thought of as a supplement to a linear energy calibration. An ideal detector would 

follow this linear calibration across all energies of interest. Deviation pairs can describe the deviation 

from linearity as a set of energies paired with the amount of deviation (in energy). GADRAS-DRF fits a 

cubic spline to the deviation pairs to determine a continuous function of deviation across the entire 

energy range. 

Note: Deviation pairs can also be applied to quadratic, or higher-order polynomial fits, but is not 

recommended 

The primary benefit of deviation pairs is the level of accuracy that can be obtained without the artifacts 

introduced by large coefficients in higher-order polynomials. In addition, the deviation pairs for a given 

detector appear to be constant. Thus, even with gain and offset drifting, as long as the gain and offset 

can be established with occasional calibration (or automatic calibration), the same deviation pairs can 

be applied (without modification) to achieve a high degree of accuracy in energy-calibration. A further 

explanation of deviation pairs can be found in Reference [8]. 

Deviation pairs are stored in a PCF file (but can also be written to the detector folder to Deviation.dat 

for reuse). The current deviation pairs can be accessed in multiple ways. From the PCF Viewer window 

under Edit->Deviation Pairs, from the Tools tab, and from the Plot window under Tools->Edit Deviation 

Pairs. The only requirement is that there is a spectrum file currently open and editable. 

Note: the presence of deviation pairs is indicated in the bottom status bar of the PCF Viewer window 

For this example, we will use the 3x3\NaI MidScat detector’s Cal.pcf, which has deviation pairs defined. 

After opening the Cal.pcf file in the PCF Viewer, the Edit->Deviation Pairs option brings up the 

Deviation Pairs Editor window as shown in Figure 34. The deviation pairs in a PCF file can be different 

for multiple detectors in a single system (for more information on multiple detectors and naming 

convention, see Section 7). The editor allows the user to choose which Detector ID to view/edit. For this 

file, there is only one detector (Aa1). The deviation pairs are listed in two columns in the text box. The 

first column is the deviation point (usually a photopeak energy) in keV. Those are paired with the second 

column, which is the amount of deviation from linearity in keV. 

Deviation pairs should be reasonably spaced in energy. Placing deviation pairs close together can cause 

erratic behavior. They should also be smoothly decreasing or increasing across the deviation points. 

Oscillating deviations is an indicating of improper use. 



67 

 

 

 

Figure 34. Deviation Pairs Editor 

For this example, the deviation pairs are erased from the file by highlighting all the text in the window, 

and pressing backspace or delete. Then clicking apply. The result should appear as in Figure 35. Click OK 

to close the window. 
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Figure 35. Deviation Pairs Editor with Deviations Erased 

Plotting the 228Th spectrum (background subtracted) along with the default calibration source yields a 

plot shown in Figure 36. Notice that the gain looks approximately correct, but mid-range photopeaks are 

not matched well. This is a typical starting point for a new detector without any deviation pairs defined. 

The recommended procedure is: 

1. Erase all deviation pairs in the deviation pairs editor and close the editor. 

2. Ensure that there is no quadratic or higher-order terms in the PCF file by asserting zeros in 

the PCF Viewer energy calibration coefficients at the top of the window. 

3. Plot a source or source(s) which can provide a good high-energy peak and low-energy peak 

to establish the gain and offset, respectively. This can be done using the graphical energy 

calibration discussed in Section 6.2. 

4. The two peaks used for gain and offset should be exactly correct in energy. These are our 

“anchor points”. Insert the anchor point energies in the Deviation Pairs Editor window with 

zero deviation. Click apply. 

5. Plot spectra and add deviation pairs as needed. 

Steps 1-3 are left as an exercise to the reader. This tutorial begins on step 4. 
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Figure 36. 228Th Spectrum without Deviation Pairs 

After the anchor points are determined (239 keV and 2614 keV from 228Th are convenient), open the 

Deviation Pairs Editor, set their deviations to zero, and click apply (see Figure 37). Note that the plot 

window has displayed horizontal blue dashed lines to indicate the location of deviation points. Because 

these are anchor points, and their deviations are zero, we have not affected the energy calibration from 

linear. 
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Figure 37. 228Th Plotted with Deviation Pair Anchor Points Applied 

Zoom in on the 583 keV peak in the same spectrum. Right-click and hold on the measured 583 keV 

photopeak. The plot window should appear as in Figure 38. Notice that the plot window is outlined in 

purple indicating we are adding a deviation pair. Drag the measured photopeak to the simulated 

photopeak in red. Release the right mouse button to complete the action. The spectrum will recompute 

with the new deviation pair, and the deviation will be added to the deviation editor. The resulting plot 

and deviation pair editor should appear as in Figure 39. This process can be repeated by plotting 

multiple calibration sources, and adding deviation pairs as needed. Users can manually edit the numbers 

to tweak the deviation pairs after adding them graphically, or just add them manually entirely. Ensure 

that the deviation pair editor window is closed after finishing. 
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Figure 38. 228Th Spectrum, Zoomed into 583 keV Peak, Adding Deviation Pair 

 

Figure 39. 228Th Spectrum After Deviation Pair Added to 583 keV 
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7 TIME HISTORY 

Some detector systems have the capability of taking multiple spectra over a period of time in order to 

create a time-segmented series of spectra.  By summing spectra over a specified time period, users can 

gain insight into a time-dependent scenario that would not otherwise be attainable with conventional 

spectra.  The TimeHistory tab allows users to plot and manipulate these types of spectral records.  Upon 

opening the TimeHistory tab, users are presented with a screen involving several input fields as shown 

in Figure 40.  Users may specify the following: 

 File: The spectra file containing the time history spectra 

 Time Start (optional): Time in seconds to start summing (default: 0 s) 

 Time End (optional): Time in seconds to end summing (default: end of file) 

 Photons/Neutrons/Both: The particle(s) of interest to display (default: Photons) 

 Detectors: If there are multiple detectors specified in the file, this panel box specifies which 

detectors to display the data from (default: all detectors) 

 Include Background: Whether a background should be specified to subtract from the specified 

foreground (default: not checked) 

 Include Computed Spectrum: Whether a computed spectrum should be displayed on the Time 

History graph display 

Although no time history spectra are distributed with GADRAS-DRF, a detector and spectrum have been 

displayed here for the sake of example. As shown in Figure 40, the inputted filename is 

“SearchData.n42”. N42 is a common search-file format. GADRAS-DRF internally converts the N42 to PCF 

file format. Users can either type the name of the file in (must be in current detector folder); or, open a 

search file using the PCF Viewer, and dragging one of the records into the File field on the TimeHistory 

tab. 

Once the file is specified, GADRAS searches for all detector names in the file and displays them on the 

right side of TimeHistory tab as shown in Figure 40. The convention for naming detectors follows the 

convention for naming portal detectors: 

[A-H][a-d][1-8][N (optional)] 

the first field [A-H] is the “panel”, [a-d] is the “column” within the “panel”, [1-8] is the multi-channel 

analyzer (MCA) within the “column”, and [N] is an optional character indicating it is a neutron detector. 

This allows complex detection system with many detectors to share the same spectral file, as their 

energy calibration coefficients may be different. The simplest example is a detection system with one 

detector, the name is “Aa1”. The example file shown in Figure 40 has many detectors. They are arranged 

graphically that is typical of portals. Panels A, B, C, D are on either side of the inspected vehicle or cargo, 

panel E is below the vehicle, and panel F is above. 
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Figure 40. Time History Page 

7.1 Plotting Time History Spectra 

By default, GADRAS-DRF will use all detectors in the Time History plot. Users can check or uncheck 

detectors from the TimeHistory tab. After specifying a file and any desired options, the user may click 

Plot to display the time history spectrum graph.  GADRAS-DRF generates two graphical displays as 

shown in Figure 41.  The first display shows the time history data where the x-axis is the time in seconds 

since the data collection started and the y-axis is the total count rate per detector.  The second display is 

the sum of all spectra contained in the specified time period.  By default, the second display shows the 

summed spectrum across the entire collection time (in this case, 12 detectors multiplied by 429 seconds 

each, equals 5148 total time).  The right side of the Time History display gives the user several options to 

manipulate the displays.  By default, Zoom is selected, which allows users to zoom in and out of the 

Time History graph without affecting the sum display.  This action is performed by dragging across the 

display, similar to normal graph displays.   
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Figure 41. Time History Display (top) and Sum Spectrum (bottom) 
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Select Foreground allows users to select a portion of the Time History display to sum across.  When this 

option is selected, dragging will generate a red rectangle which indicates the portion of the spectrum 

that is being summed (Figure 42). 

 

Figure 42. Selecting a Foreground to Sum Over 

Upon selection of a foreground, the Time History Sum display updates automatically to display the sum 

over the selected time region (Figure 43).  As shown, the title of the spectrum reflects the specified time 

interval (“Foreground: 273s to 299s”).   
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Figure 43. Time History Sum over Selected Time Interval 

Users may elect to display a background-subtracted spectrum.  To do this, the user should click Select 

Background and select the portion of the Time History display corresponding to the background.  

Dragging will generate a blue rectangle, which indicates the portion of the spectrum to sum over and 

use as the background as shown in Figure 44.  Note that the summed foreground and background 

spectra will be normalized by time and thus display the background-subtracted count rate for the 

selected regions.  The resulting background subtracted spectrum is shown in Figure 45.   
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Figure 44. Selecting a Background to Subtract from the Specified Foreground 
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Figure 45. Background-Subtracted Spectrum 

When the user specifies a foreground or background on the Time History graph display, the main page is 

being updated with this information, as shown in Figure 46.  The user may specify the foreground or 

background on this page and click Plot to update the graph display forms appropriately. 
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Figure 46. Foreground and Background Time Periods Are Updated on the Main Display 

In addition to dragging across the spectrum or manually specifying the times on the main form, there 

are several ways to specify the foreground and background time segments.  If the segments are already 

displayed on the time history display form, users can drag the edge of the rectangle to move the 

boundary to a different time position.  The time sum spectrum will automatically update when the 

boundary position is selected.  The user may also right-click inside the rectangle and choose to delete 

the selection or manually specify the boundaries for the selection.  The final way to change the time 

selection is to right-click drag the time selections.  Doing this preserves the time duration, but changes 

its start/end time. 

 

7.2 Saving Time History Spectra 

Users may save time history selections for future plotting or analysis routines by clicking Save Sum in 

the top-right corner of the Time History display form.  Doing so will initiate the Save Sum Spectrum form 

as shown in Figure 47.  For most situations, the default values will suffice for the user, but there may be 

some special scenarios in which the user may want to deviate from the defaults.  Users can specify the 

following fields: 
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 File: The name of the file to save the summed spectrum to 

 Start Record: This field generally increments as users save spectra to the file; users may change 

this to overwrite previous records or start saving future records 

 Foreground Title: The title of the foreground record; default is “Foreground <start time> to 

<end time>” 

 Include background in output file: If a background is selected in the Time History display form, 

the background selection will be saved when this is selected; it will be saved as a separate 

record from the foreground 

 User defined background: If the user has defined a background, this selection will be saved 

 Background from file (if present): If the file has a background record associated, this record will 

be saved as the background in the new file 

 Calibrate and Rebin Spectra: During the summation, GADRAS-DRF will attempt to shift the gains 

for each detector individually as a function of time to match common background peaks, and 

then rebin the spectra into a linear energy structure defined by the Offset and Full-scale energy 

 Rebin Spectra: GADRAS-DRF will rebin the spectra into a linear energy structure defined by the 

Offset and Full-scale energy 

 Offset (keV): The 0th order parameter of the new energy calibration used for rebinning 

 Full-scale energy (keV): The 1st order parameter of the new energy calibration used for 

rebinning 

 Combine spectra or keep the separate?: This group box will be enabled if there are multiple 

detectors displayed in the Time History display form 

 Output only sum spectrum for all detectors (default): Sums spectra for all detectors and 

combines them into one record 

 Write separate sum spectrum for each detector: Writes the sum spectrum for each detector as 

its own record (foreground and background) 
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Figure 47. Save Sum Spectrum Form 

7.3 Computed Time History 

GADRAS-DRF also offers the ability to compute a time history spectrum and either display it individually 

or overlay it on a measured time history spectrum.  When a user checks the Include Computed 

Spectrum checkbox, the computed spectrum parameters appear along with several options near the 

bottom of the page (Figure 48).  Users may choose to specify parameters for photons or neutrons, 

indicated by the selected tab at the top of the computed spectrum parameters.  The computed 

spectrum calculations assume that the source (or sources if there are multiple) is passing by the 

detector at a constant speed.  If there are multiple sources, the calculations assume that all sources pass 

by the detector at the same speed.  The parameters are defined as follows: 

 Rel. speed (m/s): The speed at which the source(s) pass by the detector face 

 Min. distance (m): The minimum distance from the detector that the source(s) are relative to 

the detector face 

 Bkg. count rate: The background count rate across the entire time history spectrum; assumed to 

be constant across the entire contents of the file 

 Time to sou. 1(s): The time in seconds until the first source is in front of the detector 

 Peak cps 1: The maximum count rate the detector sees for the first source 

 Length sou 1 (m): The length of the first source in meters 

 Separation n (m): Separations 2-10 indicate the distance between the current source and the 

previous source 
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 Peak cps n: The peak count rate for source n 

 Length sou n (m): The length of source n 

 Cos power #1, Cos power #2, Fraction #2 power: Parameters for manipulating the shape of the 

peaks (defined further below) 

 % Template error: Chi-square is calculated based on statistics in spectrum plus an overall factor 

defined by this parameter (generally ~10%) 

 Chi-square for fit: Statistical parameter defining how well the fit adheres to the measured 

spectrum 

 Average error (%): The average amount the fitted spectrum is off of the measured spectrum 

 Peak / average: Factor defining how far the peaks are above the overall average spectrum count 

rate 

 

Figure 48. Time History Page with Computed Spectrum Options 

By clicking Save To File, the specified parameters will be saved to a file for future use.  Photon 

parameters are saved to a file with extension PAS, and neutron parameters are saved to a file with 

extension NAS.  Similarly, Load From File loads previously saved parameters from a file and 

populates the appropriate fields.  GADRAS-DRF also has the capability of fitting a computed 

spectrum to a measured time history file.  Users can select any property to vary by clicking the label 

of the parameter.  Clicking the label of a parameter will highlight the parameter’s text box, as shown 

in Figure 48.  Any parameters that are highlighted will vary when the user clicks Fit Data.  The 

computed spectrum before and after fitting the peak count rates is shown in Figure 49. 
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Figure 49. Computed Spectrum before Fit (top) and after Fit (bottom) 

The parameters Cos power #1, Cos power #2, and Fraction #2 power determine the shape of the peaks 

for the source objects.  If a bare spherical source passes by a bare detector, the source will have the 

same shape at all points in time, and thus the Cos power #1, Cos power #2, and Fraction #2 power will 

all be 0.  However, if the detector or source is shielded on the sides, the source will appear differently at 

different positions.  The equation for the rate at different locations take the form 
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𝑅 = 𝑅0[(1 − 𝐹𝑟𝑎𝑐)cos 
𝑃1 𝜃 + (𝐹𝑟𝑎𝑐)cos𝑃2𝜃] 

where θ is the horizontal angle from the source to the detector, R is the count rate at angle θ, R0 is the 

count rate of the source when the source is directly in front of the detector (θ=90 degrees), and Frac, 

P1, and P2 are empirical parameters to be fit to the measurement. In the above equation, P1 

corresponds to Cos power #1, P2 corresponds to Cos power #2, and Frac corresponds to Fraction #2 

power.  
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8 ANALYZING SPECTRA 

8.1 Graphical Analysis Using Plot Overlays from Library  

The GADRAS-DRF plotting menu allows for some preliminary spectral analysis. This graphical capability 

facilitates the comparison of selected peaks and energies in a measured spectrum with library spectra 

from the Isotope Database or the PhotoPeak List.  

The left side of Figure 50 shows an example where the PhotoPeak List form is used to overlay a 

computed spectrum for 88Y (cyan) with the measured spectrum. This display is presented after 

shift+clicking on the 898 keV peak. The activity of 88Y in this sample is estimated to be 5.13 uCi with no 

shielding. The PhotoPeak list is shown on the right side of Figure 50. If the overlay does not match, 

another peak may be chosen for comparison with the measured spectrum. 

  

Figure 50. Graph of Measured Spectrum with Overlay (left); Photopeak List with Displayed Isotope 
Highlighted (right) 

8.2 Numerical Spectral Analysis 

GADRAS-DRF is specifically designed to perform robust full-spectrum analysis. Once a detector 

calibration has been performed, various analysis techniques can be used to identify peaks and perform 

an analysis. The Analyze tab on the main window provides options for numerical analysis options. The 

analysis options available are:  

 Single Regression 
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 Multiple Regression 

 ComputeFlux 

The Analyze tab shown in Figure 51 contains text boxes that accept input for foreground and 

background spectra similar to the Plot tab. Display options for the analysis output are located on the 

right side of the Analysis tab. The ensuing plot will only subtract the background if the Strip background 

option is selected. 

For the analysis algorithms to function properly, the distance from the front face of the detector to the 

center of the source must be known or assumed to correctly calculate the intensity of the source. 

Sometimes two dose rates at two distances are provided. The 1/r2
 button is a shortcut to the Distance 

Tool (see Section 11.2.2). 

There is also an option to perform an analysis routine on a time history file by clicking the Analyze as 

Time History button.  This will perform the analysis on the time-summed spectrum.  If the user updates 

the foreground or background time segments, the analysis routine will automatically perform a new 

analysis, unless the analysis takes long (such as with ComputeFlux).  In this case, after the user selects 

the foreground and background segments, they may click Analyze on the Time History display form. 

 

Figure 51. The Analyze Tab on the Main Form 
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Figure 52. Compute Spectrum Analysis on Time History File 

 

 

8.2.1 Source Libraries 

Several source libraries are generally available for inclusion in any numerical analysis, as shown above in 

the large box labeled Source Libraries (Figure 51).  

The available source libraries:  

 Isotope 

 Xray 

 Benchmark 

 CaptureGammas 

 Continuum 

 Neutron 

 SNM 
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 DetectorFolder 

Other libraries can be created and included by individual users. This is done by creating new directories 

under GADRAS-DRF\Source. Each library/directory contains a series of files that defines emission rates 

of gamma-rays or neutrons.  

Within each library are lists of sources that can be selected for use in the current analysis by clicking on 

the individual source designator. The selected sources are then available for analysis. Multiple 

Regression analysis allows for multiple libraries to be utilized. 

The most commonly used library in a typical analysis is the Isotope library. Figure 53 shows the Isotope 

library window with several of the isotopic sources selected and highlighted (blue). Users may select 

various groups of isotopes in the Group Selection Options portion of the window. The group selection of 

isotopes carries no guarantee of accuracy or completeness; it is provided only to save time in selecting 

such isotopic groups. These groups include: 

 Fission – fission daughter products 

 Natural –naturally occurring isotopes 

 Medical –typical isotopes used as radiopharmaceuticals and sources for imaging and 

therapeutic use 

 Calibration – isotopes often used as laboratory calibration sources 

 SNM – isotopes typical of uranium and plutonium 

 Automatic – automatically chooses potential isotopes from the library based on a simple peak 

identification algorithm  

 

Figure 53. Isotope Library Window 
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Fitting the continuum caused by the presence of a neutron source cannot be done by selecting a 

neutron emitter (e.g., 252Cf) out of the gamma-ray Isotope library. Instead, it must be done with an 

appropriate selection from the Neutron library.  

8.2.2 Introduction to Linear Regression Analysis 

GADRAS-DRF contains two routines used to analyze gamma-ray spectra by linear regression. The two 

programs, located on the Analysis screen have the same user interface and analysis approach, but are 

used for different purposes.  

 Multiple Regression performs a similarity (chi-square, χ2) analysis with the assumption that 

several gamma-ray sources are contributing to a measurement. For example, in the case of a 

radioactive fallout measurement, several radionuclides will be present and should be included in 

the analysis.  

 Single Regression performs a similarity (chi-square, χ2) analysis to rank individual gamma-ray 

sources to a radiation measurement. This option should be used when it is anticipated that only 

one source heavily dominates the spectrum. 

Both analysis routines report a χ2, which indicates the deviation between the measured data and the fit 

(relative to estimated uncertainties in the two sets). If the data is of good quality and is energy-

calibrated well, and the detector-response function is good, the value of χ2 should be near unity if the fit 

matches the data.  

The spectrum to be analyzed is selected by dragging and dropping a foreground and background 

spectrum from the PCF Viewer into the foreground and background text boxes (or by entering it 

manually). Multiple and Single Regression analyses attempt to fit the measured spectrum with selected 

source(s). Shielding parameters can be estimated to characterize effects associated with intervening 

materials. The shielding parameters describe intervening materials by an effective atomic number (AN) 

and areal density (AD). Selected isotopes are ranked for consistency with the measurements when 

Single Regression is performed and more than one isotope is selected. Multiple Regression finds the 

combination of selected isotopes and associated activities that gives the best fit to the spectrum. 

Parameters associated with intervening materials can be adjusted by clicking on the AN and AD labels 

(clicking these labels highlights the adjacent boxes, turning them cyan). There is also a check box for the 

option of allowing independent shielding for each radioactive source in the measured spectrum.  

8.2.2.1 Single Regression Analysis 

The Single Regression option ranks individual gamma-ray sources for their similarity (χ2) to a radiation 

measurement. It is used when it is anticipated that one source heavily dominates the spectrum. Any 
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combination of sources can be selected by the user from the available source libraries (see Section 0), 

Source Libraries, for description). Figure 54 shows the Single Regression tab with the selected sources 

from the available source libraries. To perform the analysis, click the Analyze button at the bottom right 

corner of the page. 

 

Figure 54. Single Regression Analysis Tab 

 

 

Single Regression analysis generates a single graph of the best fit data and a summary page. The best fit 

is plotted as shown in Figure 55, and the summary page ( 

Figure 56. Single Regression Analysis Summary Page 

 

) ranks the selected isotopes based on similarity to the measurement using the reduced chi-square (χ2). 
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Figure 55. Single Regression Analysis Results of Unshielded 88Y Spectrum 

 

 

 

Figure 56. Single Regression Analysis Summary Page 
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8.2.2.2 Multiple Regression Analysis 

The Multiple Regression analysis algorithm finds the combination of sources that gives the best fit to 

the measured spectrum. A reverse regression technique is used in which a combination of all spectral 

templates is utilized. Subsequent iterations gradually remove sources that do not contribute to the fit.  

When performing this procedure, users have the option to allow an intervening, adjustable 

absorber/shield to obtain the best fit. This is done by activating the boxes labeled AN and AD. 

Calculations can take several minutes if a large number of sources are selected, especially if the 

shielding is allowed to vary.  

 

Figure 57. Multiple Regression Analysis Tab 

 

 shows the Multiple Regression tab with the same 88Y spectrum as the foreground, except we have now 

also removed the background to allow the multiple regression to fit the background components. We 

have also allowed the shielding AN/AD to vary, as well as allow independent shielding for each 

radionuclide. 
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The Multiple Regression analysis generates a single graph of the best fit data and a summary page. The 

graph will indicate the relative effects of each isotope in the overall fit if the Fill Templates option has 

been selected. The graph shown in Figure 58 displays each selected source’s contribution. The summary 

of the multiple regression analysis results shown in  

Figure 59. Multiple Regression Analysis Summary Page 

 

 displays the analysis results in text form (isotope list, activities, weights, and shielding information). The 

text string found at the bottom of the summary page can be copied and pasted to the source line 

(Source for Computed Spectrum) on the Plot tab for plotting as an overlay for comparison with 

measured data. 

 

Figure 57. Multiple Regression Analysis Tab 
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Figure 58. Multiple Regression Analysis Results of 88Y Spectrum and Background 

 

 

Figure 59. Multiple Regression Analysis Summary Page 
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8.2.3 Compute Flux 

The ComputeFlux algorithm can be selected as shown in Figure 60 

Figure 60. ComputeFlux Analysis Tab 

. The ComputeFlux tool estimates the incident flux from the measured spectrum by performing 

nonlinear regression analysis. Prior to analysis, the user should select the appropriate spectral files for 

the foreground and background. A graphic plot of the results displays peak and continuum terms as 

shown in Figure 61. The flux profile is also saved in a file with a GAM extension.  

 

 

Figure 60. ComputeFlux Analysis Tab 
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Figure 61. Graph of ComputeFlux Showing the Peaks and Continuum from the Flux Calculation 
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9 NEUTRON DETECTORS 

The Neutron tab allows users to model neutron detectors. Neutron detector response information is 

stored in files named Neutron$XX.gadras, where “XX” is the name of the neutron detector. Neutron 

detector files must be stored in a gamma detector directory and thus be associated with a gamma 

detector. If a scenario arises in which no gamma detector was used, users must create a “dummy” 

gamma detector before they can access the Neutron tab. Doing this will not affect the neutron detector 

results. If no neutron detector is associated with the current gamma detector setup, the Neutron tab 

will look similar to Figure 62. 

 

Figure 62. Neutron Tab without Selected Neutron Detector 

 

9.1 Creating a New Neutron Detector 

Users can create a new neutron detector by clicking on the File menu, then Create New Neutron 

Detector. A new form will appear prompting the user to input parameters to create a new neutron 

detector (Figure 63). Users must enter a name for the detector, the source-to-detector distance in cm, 

and the height of the detector in cm. Users may then either choose to clone a common detector, clone 

an existing detector, or create a new detector from known parameters. 
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Figure 63. Create New Neutron Detector Form 

 

To clone a common detector, users can select a detector from the drop-down list and click Clone. To 

copy an existing detector, users can click Browse and navigate to the existing detector file 

(Neutron$*.gadras). This detector file can be in another directory. This is useful when the same neutron 

detector is used with multiple gamma detectors. 

To create a detector from existing parameters, fill out the bottom portion of the form (Figure 63). The 

required parameters are: 

 Moderator Area (cm^2): the surface area of the moderator surrounding the detector as seen by 

the source 

 Front PE Thickness (cm): the thickness of polyethylene in front of the detector as seen by the 

source 

 Back PE Thickness (cm): the thickness of polyethylene behind the detector as seen by the source 

 Eff. Enhancement: used to resolve differences between observed and computed efficiencies 

 Cadmium Cover: checked if the detector is surrounded by cadmium 

After specifying the parameters, click the Create button to create a new neutron detector. 

9.2 Neutron Detector Characterization 

After creating a neutron detector, the parameters on the Neutron tab are activated and the initial 

settings are filled in. Users can then fill in more information about the neutron detector: 
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 Moderator Height (cm): the vertical height of the moderator 

 Moderator Width (cm): the horizontal width of the moderator 

 Setback (cm): the distance from the front face of the detector to the moderator face 

 Thermal Cutoff Back and Sides or % Covered by Cadmium: the energy at which neutron are 

killed if they enter from the back or sides of the detector housing, or the percent of the detector 

covered by cadmium 

 Detector Neutron Lifetime (μs): the average lifetime of the neutron in the detector in 

microseconds 

After the initial detector parameters are input, the Calibration Measurements section can be 

completed. The first drop-down menu describes the overall scattering environment for the calibration 

measurements. The following options are available: 

 No reflected neutrons: the environment does not scatter any neutrons into the detector 

 Outside or large bay: the environment scatters neutrons only from the floor 

 Inside above suspended floor: neutrons are scattered from the walls and floor; the floor is 

assumed to be above ground and fairly thin 

 Inside above concrete on ground: neutrons are scattered from the walls and floor; the floor is 

assumed to be infinitely thick 

The following parameters should be filled in before attempting to characterize the detector: 

 Distance (cm): The distance from the center of the source to the detector face 

 Height Above Floor (cm): the height of the detector above the floor 

Once the parameters are filled in, characterization measurements using 252Cf should be recorded. The 

calibration source should be in the source database (see Section 11.1.1). The name of the source is 

252CF_serialNumber where serialNumber is the identifying serial number of the 252Cf source. The date of 

the measurements should be recorded. Once this information is present, GADRAS_DRF will calculate the 

activity of the source during the measurements and display the information in the corresponding 

textbox. Alternatively, users can input a known activity of 252CF (e.g. “252CF,100uC") into the name field; 

however, this is not recommended. 

A range of moderated 252CF sources is required for GADRAS-DRF to determine the proper energy-

dependent response function of the neutron detector. Measurement information for each moderated 

sources is recorded in the table on the bottom of the form. The source configuration can be selected 

from the following: 

 Background: measurement taken with no source 

 Cf252-Bare: measurement taken with bare 252Cf source (no shielding or moderator on source) 

 Cf252-XXcm-PE: measurement taken with XX cm of polyethylene surrounding the source 
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 Cf252-XXcm-BPE: measurement taken with XX cm of borated polyethylene surrounding the 

source 

For each measurement, the Live Time and the total number of counts should be recorded in the table. 

The net count rate will be computed automatically. The computed count rate will be computed based 

on the parameters entered in the form.  The Neutron Background button will bring up the Neutron 

Background form (Figure 64). This form determines the cosmic flux that can be expected during the 

count. Users can select a pre-defined location from the dropdown list, or they can input the latitude, 

longitude, and elevation themselves. Users should specify whether the experiment was taken in a 

building below multiple floors, or they can specify the areal density themselves. The reference date can 

be changed to match when the measurement was taken. As a reference, the cosmic neutron rate 

relative to the average rate New York City is given. 

 

Figure 64. Neutron Background Form 

The Adjustable Parameters box holds parameters that can be optimized to improve the neutron 

detector model. By clicking the label of the adjustable parameter, users can specify whether they want 

the parameter to be adjusted. By clicking the Fit button, GADRAS-DRF will optimize the cyan colored 

parameters using an iterative non-linear regression algorithm. The computed count rate in the 

measurement table will be updated with the optimized parameters. Clicking the Clear button will reset 

all of the parameters on the form. 
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9.3 Neutron Response 

The response function of the neutron detector to any measurement scenario (different from the 

calibration measurement scenario) can be analyzed in the Response tab. Users can see the efficiency of 

the detector plotted in red. Users can specify the measurement environment, the distance, and the 

height for the measurement.  

Once a source GAM file (or 252Cf activity) is specified in the GAM/3DM File field, the leakage from the 

source will be plotted in blue (note: this does not work for SNM radionuclides like 240Pu, users must have 

a GAM file for SNM). The units for neutron leakage is changed in the Plot Options box. The choices are: 

1. Diff. Neutron Leakage (n/eV/s): this is the neutron group leakage into 4π, with each group 

divided by the group-width in eV 

2. Neutron Leakage (energy * diff. leakage (n/s)): this is the differential leakage as described 

above, multiplied by the average energy of each group (default) 

In addition to the plot, the leakage from the source, estimated multiplication, detector count rate, 

intrinsic efficiency and absolute efficiency fields are populated. Here, intrinsic efficiency is defined as the 

percentage of neutrons that are detected, given they strike the neutron detector. The absolute 

efficiency is defined as the percentage of neutrons that are detected, given they leak from the source. 

There is also a Quick Source Activity Estimate box which allows users to input a recorded count-rate 

from a detector. GADRAS-DRF will estimate the equivalent bare and moderated 252CF activity at the 

specified distance/height/measurement environment. 
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Figure 65. Neutron Response Tab 
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10 INJECT CALCULATIONS 

10.1 Creating Inject Data 

GADRAS-DRF has the capability of synthesizing spectra for training or demonstration purposes.  The 

results of these computations are called inject spectra.  There are three main sections that should be 

discussed when creating inject data.  They are the general settings, detector settings, and background 

settings.  The inject page may be seen in Figure 66. 

 

Figure 66. Inject Page 

10.1.1 General Settings 

Users may specify a variety of properties when creating inject data.  The general settings include: 

4) Date/time: The timestamp that should be assigned to the spectrum; users may type in a date and 

time or select one from the calendar icon 

5) Output File: The name of the output file for the inject data 

6) Record: The record number for this inject run 

7) Title: The title of the run 
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8) Source (optional): The source information to include in the inject data; this field is similar to that on 

the Plot page (Section 0) 

9) Distance (cm): The distance between the source and the detector face 

10) Height (cm): The height of the detector above the floor for this scenario 

11) Time (s): The amount of time that should be simulated for the run; users may also specify whether 

this is Live time or Real time 

12) Apply Poisson Statistics: When this box is checked, the inject data will have a Poisson distribution 

which simulates real measurement data; when unchecked, the data will be perfectly conformed to 

theoretical calculations 

13) Internal.pcf: If the detector has internal radioactive components (e.g. LaBr) or calibration sources 

attached to the detector, there may be a file called Internal.pcf in the detector folder, which 

contains the spectrum associated with the internal source; this checkbox allows this spectrum to be 

included in the inject data file 

10.1.2 Neutrons 

Some detectors have neutron detectors attached to them. This section allows a user to also compute 

the count-rate from the neutron detector and embed that information into the spectrum file. For a 

neutron detector to be available, the neutron detector file must be present in the current detector 

folder. 

The Reflection Environment is also important for gamma detectors measuring neutron sources, as it will 

change the rate of incident neutrons on the gamma detector, and thus the observable neutron 

interactions in the gamma detector. This is described in more detail in Section 9.2 

10.1.3 Gamma Detector 

Users may desire to change the detector settings from the default settings (imported from the current 

Detector.dat file).  

The Dead time per pulse affects the recorded live-time of the simulation. Typical values are between 10 

and 20 microseconds. 

The True Energy Calibration is the energy calibration parameters used to determine the channel group 

structure for the simulated spectrum. This can also be used to change the full-energy-range of the 

detector by changing the Order 1 to the full energy in keV. 

The Recorded Energy Cal is what is recorded in the spectrum file. This may be different than the true 

calibration to simulate uncalibrated or poorly calibrated spectra. 

The Resolution parameters allow users to simulate subtle differences between different detectors of 

the same type, which have different resolution, or may have resolution changes with time or 

temperature. 
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Clicking the Defaults button will adjust the energy calibration and resolution parameters back to the 

default parameters assigned to the detector. 

10.1.4 Background Settings 

Background radiation primarily comes from two sources: cosmic and terrestrial.  Cosmic radiation 

contribution to the spectrum is mainly a factor of elevation and material above the detector.  This 

material may include shielding or building material.  Terrestrial background is mostly composed of 40K, 

the uranium decay chain, and the thorium decay chain.  The following settings can be specified 

regarding background: 

14) Location (dropdown menu): The latitude, longitude, and elevation for many cities across the world 

are stored in GADRAS-DRF; selecting an option from this dropdown menu will automatically fill 

these fields in the location info 

15) Latitude (deg N): Latitude of the simulated measurement 

16) Longitude (deg E): Longitude of the simulated measurement 

17) Elevation (meters): The elevation of the simulated measurement 

18) Floors Above or g/cm^2: Users may specify the aerial density of the material above the detector if it 

is known; otherwise, users may specify the Floors Above parameter and the aerial density will be 

estimated; this is used to generate the cosmic background attributed for the simulated spectrum 

19) Include (terrestrial background checkbox): Specifies whether terrestrial background calculations 

should be included in the simulated spectrum 

20) K%: The weight percentage of potassium in the soil; for reference, 1% corresponds to 7.8 g of 40K 

(54.47 μCi) in a 1 meter radius sphere 

21) U ppm: Amount of uranium in soil in parts per million; for reference, 1 ppm corresponds to 2.236 

μCi 238U, 2.236 μCi 226Ra, and 104.2 nCi 235U 

22) Th ppm: Amount of thorium in soil in parts per million; for reference, 1 ppm corresponds to 6.7 g 
232Th (732.3 nCi) in a 1 meter radius sphere 

23) Attenuation: Amount of attenuation the terrestrial background goes through before encountering 

the detector 

24) Low-E Continuum: Amount of low-energy continuum the terrestrial background will contribute; this 

can be based on materials between the soil and the detector or how much soil is present near the 

detector 

25) High-E Continuum: Amount of high-energy continuum the terrestrial background will contribute 

26) Include Cosmic: Specifies whether cosmic background calculations should be included in the 

simulated spectrum, this is the primary source of neutron background for the calculations 

Users may click the Estimate NORM for location button to estimate the naturally occurring radioactive 

material (K, U, and Th) for the location specified in the Location dropdown menu.   

Note: this only works for cities in the U.S. 
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Once all the settings have been specified, clicking the Compute button will generate the output.  The 

PCF Viewer window will open and be populated with the file specified in the Output File text box.  The 

graph display will also appear and display the simulated inject data.  The settings will all be saved in a .inj 

file, which has a default file name format of <outputFileName>-<RecordNumber>.inj.  Users may choose 

to save the settings without running the inject using the Save As inject file… option in the File menu.  

The auto-save feature can be disabled from the Options menu.  Users may also populate the settings 

from an inject file by selecting Open inject file… from the File menu. 

10.2  Batch Inject 

Users may need to generate a large amount of inject data.  This can become a tedious process if done in 

the traditional way.  GADRAS-DRF allows users to perform batch inject calculations using a series of .inj 

files.  Users may create these text-based files themselves, as long as they follow the correct format.  To 

perform a batch inject calculation, users should click the Batch button on the inject page.  This will bring 

up the batch inject form as shown in Figure 67. 

 

Figure 67. Batch Inject Form 

To perform a batch inject calculation, select the desired files to perform the inject calculations with.  If 

none of the files are highlighted, all of the displayed inject files will be included in the batch calculation.  

The File name format text box can be used to populate the form with different files.  Note: files do not 

need the .inj extension to be used in batch calculations. 
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11 GADRAS-DRF TOOLS 

11.1 GADRAS-DRF Editors and Libraries 

Editors for various libraries and properties can be found under the Tools menu option on the main 

window, as shown in Figure 68. Editor options include: 

 Deviation Pairs (discussed in Section 6.3) 

 Isotope DB (discussed in Section 6.1.2) 

 PhotoPeak List (discussed in Section 6.1.1)  

 Source DB (Source database) 

 

Figure 68. Tools Tab 

 

11.1.1  (Calibrated) Source Database (DB) 

27) Users can access the Source DB form from the Tools tab on the main window. This form displays a 

database of known calibration sources with various properties. The source list is located in the 

Source.lib file in the root GADRAS-DRF directory. When GADRAS-DRF is updated to a new version, 
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user-added sources are automatically retained. Sources are added and identified according to their 

unique Source ID. 

Source DB includes the following information for each calibration source: 

 Source ID —Naming convention: atomic weight followed by the elemental symbol (e.g., 109Cd) 

+ underscore + alphanumeric information (i.e., serial number or other identifying information).  

 Original Calibrated Activity  

 Original Calibration Date  

 Location  

Calibration sources are grouped by radionuclide on the Source DB form. Clicking the tree-expand button 

(the + to the left of each isotope name) allows the user to view all calibration sources for that 

radionuclide. Users may edit or delete existing sources or add new sources using this form.  

When computed spectra are compared with measurements, activities for stored calibration sources are 

decay-corrected based on the Calibration Date, the Calibrated Activity, and the measurement date of 

the plotted spectrum. An activity calculator is provided at the bottom of the window for users to obtain 

decay-corrected activities for each source. Figure 69 illustrates a listing of calibration sources for 109Cd 

and the activity calculator. 

  

Figure 69. Source DB Tool with a 109Cd Source Highlighted 
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11.1.2 Spectrum File Tools 

GADRAS-DRF has the capability of manipulating spectra to perform desired tasks or calculations.  This 

may include adding or subtracting spectra, scaling a spectrum, applying Poisson statistics to a record, or 

other calculations.  The Spectrum Tools form is shown in Figure 70. 

 

Figure 70. Spectrum Tools Form 

The Examples tab demonstrates the available functions in the spectrum tools form.  To type a file name 

at the current cursor location, the user may click the filename from the list box or manually type the file.  

If a file name includes special characters such as spaces or operators (e.g. +, -, /, *), the file name should 

be put in quotes (e.g. “my+spectrum.pcf”).  This ensures the file name is not misinterpreted as an 

operation.  Clicking Submit sends the command to GADRAS-DRF.  If it is a valid command, it will appear 

in the History tab, otherwise, GADRAS-DRF will warn the user that the command is invalid.  Users can 

repeat a command by clicking on the command in the History tab.  To clear the History, the user may 

click Clear.  Users may perform batch operations by writing multiple commands on separate lines in a 

text file.  When the user clicks Batch, they should select the file with the commands.  GADRAS-DRF will 

perform the commands sequentially.  If one of the commands is invalid, GADRAS-DRF will inform the 

user which of the commands was invalid and which commands were executed successfully.  GADRAS-

DRF will also inform the user if all the commands were executed successfully. 
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11.2 Calculators 

11.2.1 Dose Calculation  

The expected dose (exposure) rate from almost any source can be calculated using GADRAS-DRF. Note: 

this calculation is independent of detector characteristics and any internal or external shielding. 

However, GADRAS-DRF does compensate for attenuation and scattering by intervening air. Based on 

methods specified in ANSI/ANS‐6.1.1‐1991, “Neutron and Gamma‐Ray Fluence‐to‐Dose Factors,” 

effective dose equivalent rates for an anthropomorphic representation of the human body can be 

calculated.  

The Dose Calc button is located under the Tools tab on the main form. The radionuclide source strength 

can be provided as activity (Curies) or mass (grams). Information needed for a dose calculation includes 

the following: 

 Preferred dose units: Select output units via drop-down menu (Rem or Sievert)  

 Source (radionuclide and source strength): Radioactive source information (e.g., “137Cs, 

100uC”; a known source from Source DB; or a model file name) 

 Distance: source-to-detector distance (cm) 

 Gamma Energy Threshold (optional): any gamma emissions below the specified threshold 

energy (keV) are excluded when the gross leakage is tallied (Note: this only affects the gross 

leakage, not the computed dose). 

The following calculated rates are shown in Figure 71: 

 Gamma Dose 

 Neutron Dose 

 Total Dose 

 Gross Leakage (gamma) 

 Gross Leakage (neutron) 
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Figure 71. Dose Calculation Tool 

11.2.2 Distance Calculator 

The distance calculator uses dose rates taken at two different positions to estimate the distance to the 

source. This can be useful if the source is inside a large container and the exact position is unknown. This 

form uses ratios of dose rates and distances, so units are arbitrary as long as they are consistent. An 

example of the form can be seen in Figure 72. 

 

Figure 72. Distance Calculator Tool 
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The Distance from Ref. Pt. should be entered as a distance from a consistent position that is in line with 

the source (i.e. the source and the two measurements should form a line and the distances should be 

entered from an arbitrary point on the line). One caveat is that if the source is not in line with the two 

measurement points, the resulting position may not be accurate. 

The scatter environment can impact the dose rate measurements. Because of this, the distance 

calculator gives users the option to estimate the scatter environment. Most of the time, users should 

use the Mid Scatter option (Power Law: 1.85). Low Scatter (Power Law: 2.0) should be used when the 

floor is very thin or non-existent and there are no walls nearby. High Scatter (Power Law: 1.65) should 

be used when the measurement is taken in a compact area, such as a vehicle. Users also have the option 

of specifying their own Power Law if this value is known. 

11.3 Other Tools 

11.3.1 Rebin Tool 

The rebin tool creates a file called Rebin.dat for a particular detector. This tool should be used when 

users want to rebin a spectrum into a specific energy bin structure. The form can be seen in Figure 73. 

 

Figure 73. Rebin Tool 

The Minimum Energy should be the energy of the low edge of channel 0. Maximum Energy should be 

the energy of the upper edge of the maximum channel. The Energy Power and Zero Intercept fields are 

used to determine the bin width as a function of energy. To have uniform bins in the continuum, the 

Energy Power should be 0. The bin width will be determined by the minimum and maximum energies, 
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as well as the number of channels. In Figure 73, the bin width will increase as the square root of the 

energy, and the channel corresponding to 0 keV will have a bin width of 1 keV. 

Users may define the number of channels in two ways. By selecting the Number of Channels option, 

users can define the total number of channels to use. The continuum and peaks will have the same 

binning structure. If Continuum Resolution is selected, users can specify separate bin widths for the 

continuum and the peaks. The Continuum Resolution textbox defines the bin width as a percentage of 

energy at 661 keV. The bin width Δ𝐸 (keV) for the continuum is determined using 

Δ𝐸 = 𝐶1−𝑝𝐸𝑝 + 𝐸0, 

where 𝐸 is the bin lower energy bound in keV, 𝐶 is the Continuum Resolution (at 661 keV) in keV, 𝑝 is 

the Energy Power, 𝐸0 is the Zero Intercept in keV. For example, in Figure 73, the Zero Intercept is 1 keV, 

the Energy Power is 0.5, and the Continuum Resolution is 3%. Therefore, at 1000 keV, the bin width is 

25.4 keV. By default, the continuum resolution is also used for energy bins containing peaks. If the 

“Narrow bins around peaks defined in Photon.lis” checkbox is checked, users can define a different bin 

structure around peaks. Photon.lis is stored in the root GADRAS-DRF data directory (default is 

C:\GADRAS-DRF) and is universal for all detectors. Users can modify this file to include peaks they wish 

to have more bins in or remove peaks they wish to ignore. An example of the Photon.lis file can be seen 

in Figure 74. 

 

Figure 74. Photon.lis File 

To modify this file, users can input the energy in the first column, the nuclide name in the second 

column, the absolute yield (%) in the third column, and the detectability (based on energy and yield) in 
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the fourth column. The Rebin tool only reads the first column; the rest of the columns are ignored. Only 

peaks within the specified energy range will be used. The default file is sorted by energy, but users may 

input peaks in any order. Users may select a constant bin width for peaks, or may use the percent of the 

peak’s energy as the bin width basis. The Rebin tool will assign one bin to the peak with a width 

corresponding to the specified energy or percentage of peak energy. If the annihilation peak at 511 keV 

is specified, the bin width is extended by 3 keV due to Doppler broadening of the peak. 

Once the parameters are filled in, users can click the Generate Data button to create the Rebin.dat file. 

The information textbox will be populated (Figure 75). The number of channels will be displayed first, 

followed by the energy bins. This information is recorded in Rebin.dat. When the Rebin.dat file is 

present in the detector directory, the Rebin checkbox on the Detector tab will be enabled. Users can 

choose whether they want the plotted spectrum to be rebinned according to the Rebin.dat file by 

checking this box. 

 

Figure 75. Rebin Data Tool with Data Generated 

11.3.2 Batch Peak Search 

Users can perform a peak search on multiple files by using the Batch Peak Search tool (Figure 76). Users 

can select which files they want to analyze using the Filter textbox. In Figure 76, all files in the current 

detector directory ending in .pcf will be analyzed. The Threshold (Sigmas) textbox defines how far above 

the continuum a peak must be to be included in the results. After the files are chosen and the threshold 

is specified, clicking OK will start the analysis. 
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Figure 76. Batch Peak Search Tool 

The tool will sequentially analyze all spectra in each of the files specified by the filter. The results will be 

stored in .csv files which are located in the Temp directory (default is C:\GADRAS-DRF\Temp). These files 

can be opened in Excel. The following data is stored in the csv file: 

 Energy (keV) 

 Energy uncertainty (sigma) 

 Count Rate (counts per second) 

 Count Rate uncertainty (sigma) 

 Full-Width at Half Max (keV) 

 FWHM uncertainty (sigma) 

 Leakage (photons per second) 
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12 GADRAS-DRF SETTINGS 

GADRAS-DRF has some settings that users can modify to customize the user interface. These options 

consist of: 

 Change plot options on detector change (default on): GADRAS-DRF will change the plot style of 

the first spectrum depending on if the detector is high resolution (e.g. HPGe) or low resolution 

(e.g. NaI) 

 Automatically update plot when fields change (default off): with this turned on, users can 

update the spectrum viewer automatically when they change any field on the Plot tab 

(Foreground, Background, Compute Source term) 

 Don’t show energy calibration dialog (default off): when doing the graphical energy calibration 

(Section 6.2), this option determines whether GADRAS-DRF will automatically ask which 

calibration parameter to adjust 

 Adjust plot scale with mouse wheel (default on): if selected, the mouse wheel will adjust the y-

axis scale on the spectrum viewer; if not selected, the mouse wheel will zoom in 

 Animate zoom (default on): if selected, the spectrum viewer will zoom in with an animation 

 Open ROI in new window (default off): if selected, zooming in will open a new spectrum viewer 

with the zoomed spectrum; otherwise, the zoom will remain on the same window 

 Reset Dialogs button: when pressed, this reset the GUI to show all dialog boxes until user checks 

the option to not show the dialog again 

 Save DLL Log button: if GADRAS-DRF functions incorrectly, this button can be used to save the 

error to a file 

 Exit splash screen upon load (default off): checking this will exit the initial GADRAS-DRF splash 

screen as soon as GADRAS-DRF is ready for user interaction, otherwise it will stay visible for a 

full three seconds 

 Turn off autocomplete (default off): the Computed Source line on the Plot tab has an 

autocomplete feature; if desired, this functionality can be turned off 

 Rebin spectra when inserting to files (default off): if checked, spectra will be rebinned according 

to the Rebin.dat file structure (Section 11.3.1) whenever they are added to a PCF file via the PCF 

Viewer 
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